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Thank you for purchasing a Picarro product. Your Picarro system is a quality product
that has been designed and manufactured to provide reliable performance.

This User Manual (UM) is an important part of your purchase as it will help familiarize
you with the system and explain the numerous features that have been designed
into it. Please read this manual thoroughly before using your Picarro system.

Please contact Picarro or your authorized Picarro distributor should you have questions
regarding specific applications or if you require additional information.

NOTICES
DISCLAIMER AND RESERVATION OF RIGHTS

Picarro has prepared this manual solely for the information and use by its customers as
a guide for the selection, installation, operation, and maintenance of the products
described.

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO
PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO
DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE
OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Picarro reserves the right to change or update the contents of this manual and the
specifications of its products at any time, without notice. Picarro has endeavored to
include information that is current and accurate as of the date of the publication or
revision of this document, but Picarro does not guarantee that this document is error free
or that it is accurate with regard to any particular specification.

Picarro expressly reserves all intellectual property rights, including all intellectual
property rights relating to any product described in this manual. This document does not
grant any license, express or implied, by estoppel or otherwise, to any intellectual
property rights of Picarro or any third party.

PATENTS

The products described in this manual are subject to Picarro patents and patents
pending. Information about Picarro patents applicable to these products is available at
www.picarro.com/company/patents

TRADEMARKS

Picarro and the Picarro logo are trademarks of Picarro, Inc.

Windows® is a trademark of Microsoft Corporation
Swagelok® is a trademark of Swagelok Company

Copyright © 2020 Picarro, Inc. All rights reserved.
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1. INTRODUCTION TO TECHNOLOGY

Picarro analyzers use time-based, optical absorption spectroscopy of the target
gases to determine concentration in a sample. They are based on wavelength-
scanned cavity ring-down spectroscopy (WS-CRDS), a technology in which light
travels many times through the sample, creating a very long effective path length
for the light to interact with the target gas, thus enabling excellent detection
sensitivity in a compact and rugged instrument.

The Picarro analyzer is comprised of two modules:

e The Analyzer contains the spectrometer, sample chamber, and a
computer with a hard drive to store and analyze data. The single
analyzer module controls the operation of the system and converts
spectroscopic measurements into gas concentration data.

e The External Vacuum Pump draws the sample gas through the
instrument.

1.1  Cavity Ring-Down Spectroscopy (CRDS)

Nearly every small gas-phase molecule (e.g., CO2, H20, H2S, NH3) and
isotopologue (e.g., H2*0, 13CO2, >N*N*0) uniquely absorb specific
wavelengths of near-infrared light. The strength of the light absorption is
related to the concentration of a molecule in a sample and the distance that
light travels through the sample, called the path length.

Conventional infrared spectrometers are typically only sensitive enough to
detect trace gases at levels in the part-per-million. Cavity Ring-Down
Spectroscopy (CRDS), on the other hand, is one thousand to one million
more times sensitive.

The increased sensitivity of CRDS is due to the design of the sample cavity
and the time-based measurement. In the cavity, a series of mirrors reflects
the infrared light through the sample, increasing the path length. For a
Picarro cavity of only 25 cm in length, the effective path length of the cavity
can be over 20 kilometers.

In Picarro analyzers, light from a single-frequency laser enters a cavity
where three mirrors reflect the laser light as seen in Figure 1. The light
enters through the mirror closest to the laser, bounces off the angled mirror
in the lower right corner of the cavity, travels to the hemispherical mirror at
the top of the cavity, bounces toward the mirror in the lower left corner of
the cavity, and then returns to the first mirror. This motion becomes a
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continuous traveling light wave, which is represented by the dark orange
path in Figure 1.

Figure 1:
Schematic of
the Picarro
CRDS analyzer
cavity
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When the laser is on, the cavity quickly fills with laser light. A small amount
of the laser light is transmitted through the mirror closest to the
photodetector, which turns the incident light into a signal that is directly
proportional to the light intensity in the cavity.

When the photodetector signal reaches a threshold level (in a few tens of
microseconds), the laser is turned off. The light contained within the cavity
continues to bounce between the mirrors (about 40,000 times). Since the
mirrors have slightly less than 100% reflectivity (99.999%), the light inside
the cavity steadily leaks out of the cavity. The intensity of the light reaching
the detector decreases, falling exponentially until it reaches zero. This
decay, or "ring-down,” is measured in real time by the photodetector.

Relating ring-down time to absorption intensity

The time it takes to ring-down is inversely related to the total optical loss in
the cavity, including the strength of molecular absorption at a given
wavelength of light. For an empty cavity, the time it takes for the intensity to
decrease by a given percent is determined solely by the reflectivity of the
mirrors. A cavity containing gas that absorbs light will have a shorter ring-
down time than an empty cavity. As the light circulates in a cavity with a
gas sample, the molecular absorption by the gas results in a decrease of
the light intensity.

P/N 40-0012 Rev. E G5310 User Manual
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Determining absorption intensity at a specific wavelength requires
comparing the ring-down time of an empty cavity to the ring-down time of a
cavity that contains gas. A cavity can be empty if it contains no gas; it will
also appear empty if the molecules of the sample inside the cavity do not
interact with the specific wavelength of light.

Picarro instruments gather measurements from an “empty” cavity by
switching the light to wavelengths that are not absorbed by the target
molecules. The analyzer subsequently measures ring-down times at
wavelengths that are absorbed by the target gas. The analyzer
automatically and continuously compares these two types of ring-down
times, and the software uses those comparisons to calculate absorption
intensities.

Figure 2:
Light intensity
as a function of
time in a CRDS
system
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Converting absorption intensity to concentration

Plotting the absorbance at each measured wavelength generates an
optical spectrum. This spectrum contains absorbance peaks that are
unigue to each molecule in the sample. The height of a particular
absorption peak is proportional to the concentration of a molecule that
generated the signal.

The height of the peak is calculated by subtracting the maximal
absorbance from the baseline absorbance. Figure 3 shows a plot of ideal
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optical spectra with a clean, uniform baseline on either side of the
absorption peak.

_.
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Figure 3:
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However, optical spectra often contain several absorption lines, nested
closely together. A particular absorption peak may be visible between lines,
but the absorption may not return to the baseline before it rises in response
to another molecule.

Picarro analyzers calculate the baseline underneath a poorly resolved peak
by modeling the absorption peaks from other surrounding molecules and
subtracting contributions from neighboring peaks to the absorption
intensity.

1.4  Spectral precision and high sensitivity measurements

Picarro analyzers contain two features that provide high spectral precision:

e A proprietary wavelength monitor (WLM) that measures the absolute
laser wavelength to a precision that is a few orders of magnitude
narrower than the spectral linewidth: Picarro’s patented WLM measures
absolute laser wavelength to a precision more than 1,000 times
narrower than the observed Doppler-broadened linewidth for small gas-
phase molecules. The instruments lock the laser to the WLM, and then
the monitor tunes to wavelengths known to be maximally and minimally
absorbed by the target molecule. The result is closely clustered
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absorption intensities, measured at wavelengths just before peak
absorption, at peak absorption, and just after peak absorption, as the
absorbance returns to the baseline.

e Precise temperature and pressure control in the sample cavity:
Accurate absorption measurements at precisely known wavelengths
account for little unless the temperature and pressure of the CRDS
measurement cavity are known. The observed line intensity and shape
depend on the temperature and pressure inside the sample cavity.
Small temperature and pressure instabilities can result in large
concentration errors due to fluctuating peak heights and baselines. To
completely minimize instrument measurement drift, temperature and
pressure must be actively stabilized to constant values.

For precise temperature control, the sample cavity is surrounded by layers
of thermally insulating material to provide a high degree of passive thermal
stability. The cavity is further actively stabilized by means of a solid-state
heating system locked to the output of a thermal sensor. This enables the
temperature of the cavity to be within 20 mK of the set temperature.

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure
data in a feedback loop to control proportional valves that adjust the inlet
and outlet gas flow of the cavity.

G5310 User Manual P/N 40-0012 Rev. E 11
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2. CONVENTIONS

The following icons are used throughout this manual to emphasize important
information in the text. These icons indicate dangers to either the operator or to the
analyzer, and other important information.

Consult the user’'s manual for important information
(When you see this symbol placed at hazard points
on equipment, consult the user manual).

aware of before proceeding.

@ NOTE is important information that you should be

LASER WARNING alerts you of a laser danger.
WARNING

& CAUTION alerts you of a potential danger to
! equipment or to the user.

& WARNING indicates an imminent danger to the

WARNING user.
() REMINDER is a helpful hint to procedures listed in
Y the text.
REMINDER
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3. ACRONYMS

This manual includes various acronyms. For definitions, see below:

CRDS Cavity Ring-Down Spectroscopy
GUI Graphical User Interface
cm centimeters
mm millimeters

" (asin 1/4”) Inches
N20 Nitrous Oxide
CO Carbon Monoxide
H20 Water
HB Hotbox
WB Warm box
ppm Parts Per Million
ppb Parts Per Billion
Yoo per mil
°C degrees Celsius
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4. SAFETY

4.1

>

WARNING

>

WARNING

>

WARNING

>

0
>
(@
4
o
z

P

WARNING

=

4

General Safety

CDRH Certification

This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and
is classified as a Class 1 laser system when all panels and covers are on.
CE Certification

This Picarro Analyzer complies with the European standards and the
instrument is affixed with a CE label. This CE label is located on the rear of
the instrument.

Using this analyzer in a manner not specified by Picarro may result
in damage to the analyzer and render it unsafe to operate.

This analyzer is for indoor use only and has an ingress protection
rating of IPx-0. Analyzer is NOT protected against exposure to
water including dripping, spraying, splashing or immersion.

Do not operate in an explosive atmosphere! Do not operate in the
presence of flammable gases or fumes.

The analyzer contains no user serviceable components except the
particulate filter, fuse, and laser chiller. Do not attempt repairs;
instead, report all problems to Picarro Customer Service or your
local distributor. Please contact Picarro if you have any questions
regarding the safe operation of this equipment.

The inlet gas connector on the back panel of the Analyzer, and its
immediate vicinity, runs hot during operation of the analyzer. Take
care when connecting gas lines or working at the rear of the
instrument to wear protective gloves or avoid contact with these
surfaces.
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A\

WARNING

4.2

WARNING

WARNING

This analyzer weighs 75 Ibs. (34 kg). Use the technique described
below when lifting the analyzer.

a. Before lifting, inspect the unit for slippery substances or sharp
edges.

b. Lift with two people, one on each side of the analyzer.
Crouch down and stay close to the unit. Always keep your
back as straight as possible.

d. Position your feet for sturdy balance. Lift with your legs, not
your back.

e. Do not twist the back while carrying the unit. Rotate direction
with hip joints.

f. Lower the unit by bending at the knees.

Laser Safety

This equipment is classified as a Class 1 laser product with an
embedded 3B laser in accordance with EN 60825-1:2014. Do not to
open the enclosure where this label is placed; there are no user
serviceable parts inside.

The following Laser Safety Label is affixed to the outer cover of the
analyzer.

& CLASS 1 LASER PRODUCT

The laser is a Class3B when exposed.

Only operate or service this device in accordance with the
instructions in this guide, and only open the device in an approved
laser safe service area using appropriate laser-safety glasses.

The following Laser Safety Label is affixed to the inside of the analyzer:

G5310 User Manual P/N 40-0012 Rev. E 15
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Figure 4:

Laser SLaa]: gz CAU TION

CLASS 3B INVISIBLE LASER
RADIATION WHEN OPEN
AVOID EXPOSURE TO THE BEAM

than those specified herein may result in hazardous radiation

g Use of controls or adjustments or performance of procedures other
WARNING  EXposure.
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5. UNPACKING THE ANALYZER

5.1

Inspect the Shipping Boxes

Picarro products are inspected and tested before leaving the factory. Their
packing containers have been designed to keep the equipment safe from
damage during transit.

Inspect the condition of the boxes upon arrival. The system is delivered in
a shipping crate divided into two sections: if the outer box shows damage,
the inner area holding the analyzer is cushioned enough that it will protect
the instrument under most circumstances.

If the equipment appears to be damaged, photograph the damages
and contact Picarro (email pictures if possible) as soon as
possible.

NOTE
The analyzer section contains:
e Analyzer
e Keyboard
e Mouse
The pump section contains:
e Vacuum pump
e Cables and hoses needed to connect and power the analyzer and
pump
Figure 4: Analyzer Pump and Cables

Shipping Crate
and Contents

G5310 User Manual P/N 40-0012 Rev. E 17
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5.2  Unpack the Shipping Crate

This section describes the contents of the shipping crate:
¢ Inspect each item to ensure it is not damaged.
e If items are missing, contact Picarro.

¢ Keep the shipping crate and packaging to reuse when transporting the
analyzer.

e Contact Picarro for options on transporting systems to remote labs.

@ This analyzer weighs 75 Ibs. (34 kg). Use the technique outlined in the
General Safety section on page 15 when lifting or moving the analyzer.

WARNING
Figure 5: Analyzer
Analyzer and
Pump
Components PICARRO
Power
indicator g:r?
soft On/Off
Pump power |
indicator
Figure 6:
Connection
Componentts » Vacuum Line
3\, — 25 Pin Cable
Power Cables (2)
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Analyzer, Pump, and Connection Components

Item (qty) Description

Analyzer (1) Includes all the data acquisition, control, and
communications hardware and firmware to
perform all gas handling, spectral collection

and analysis.
Pump (1) Provides vacuum required for sample gas
sequencing into and out of the analyzer.
Vacuum Hose Hose to connect the pump to the analyzer.
1)
A/C Power A power cable with connectors appropriate to
Cables (2) your country is provided. The analyzer
automatically adjusts to local voltage.
Keyboard (1) USB keyboard
Mouse (1) USB mouse
Multi-Pin Control | For External Solenoid Valves
Cable (1) Electronic cable (25-pin)
Nut (1) and For connecting input line to analyzer INPUT
Ferrules (2)
Document Includes this manual, certificate of compliance,
Packet (1) and Windows License.

USB Flash Drive | Contains backup software.

Unpacking the Pump Unit

1. Unpack the pump unit from the crate and plastic bag and place it on
a tabletop.

2. Remove the two screws from the black plate on the base of the PPU
and remove the plate. This plate keeps the rubber feet on the pump
(inside the PPU enclosure) from shearing off. Removing the screws
releases the pump inside the PPU, allowing it to vibrate freely. See
Figure 8.

G5310 User Manual P/N 40-0012 Rev. E 19
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Figure 7: Remove the Securing Screws
Removing the
Pump Securing
Screws

plastic bags and desiccation pouches) and re-attach it when
NOTE shipping the unit.,

@ Save the plate with the packing materials (crate, shipping foam,

3. Unpack the analyzer and remove it from its plastic bag.

4. Carefully set the analyzer atop the PPU to prepare for setup of
connections at the back. Figure 6 above shows the analzyer
positioned correctly on the PPU.

Leave enough free space for easy connections. Leave 6” free space
at the rear of the analyzer and 6” free space at the front of the

analyzer.

CAUTION

20 P/N 40-0012 Rev. E G5310 User Manual
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6. ANALYZER OVERVIEW

6.1 Intended Use

The G5310 analyzer measures concentrations of N2O, CO and H20 using
Picarro’s patented Cavity Ring-Down Spectroscopy (CRDS). The analyzer
can be deployed for air monitoring applications in a lab or in the field,
allowing in-situ analysis of trace and ambient amounts of N2O, CO and
H20

6.2  External Vacuum Pump

The external vacuum pump is used to maintain cavity pressure inside the
analyzer. The pump should be connected and running whenever the
analyzer is in use.

6.3  Analyzer Specifications

G5310 User Manual

Weight (Total)
Analyzer
Pump

95 Ibs (43.1 kg), Including pump
75 Ibs. (34 kg)
20 Ibs. (9.1)

Analyzer Dimensions

177 W x 12" H x 27" D (43 x 32 x 69 cm)

Temperature Range

15 to 35°C (operating) —10 °C to 50 °C (storage)

Sample Pressure

300 to 1000 Torr (40 to 133 kPa)

Sample Flow Rate

100 sccm

Ambient Humidity Range

< 85% R.H. non-condensing

Maximum Altitude

10,000 ft. (operation)

Clearance

Front: 6" (15.3 cm); Rear: 6" (15.3 cm)

Power Requirements
Startup Power
Steady-state Power

Mains Supply Voltage
Fluctuation

100 to 240 VAC; 47 to 63 Hz (auto-sensing)
<375 W at start-up (Analyzer and Pump)

120 W (Analyzer), 150 W (Pump) Steady-state operation

+10% of the nominal voltage

Minimum Rated Circuit
Amperage

10A @115VAC,
5A @230VAC

Liquid Ingress Protection

None

P/N 40-0012 Rev. E

21




PICARRO

6.4  Analyzer Operation Flow Diagram

To measure discrete samples (such as individual gas bags) or from
multiple locations (when switching valves draw in ambient air from different
heights), a separate software window (coordinator) is used to control the
sample source and match the corresponding real time read out with the
sample source. Depending on system configuration, coordinator programs
may not be included. Figure 9 shows analyzer operation as a flow diagram.

Figure 8:
Analyzer
Operation Flow
Diagram

data for
A
data for
B
data for
data file all data C
t=0to t=3

1. The samples A, B, and C are introduced into the analyzer
sequentially.

2. The timing of sample introduction is controlled by coordinator or
valve sequencer software.

3. The analyzer measures samples continuously and reports the data
to the GUI.

4. The GUI saves a single file where all data is reported as a function
of time. The coordinator gets data from the GUI and creates a single
file, the data is reported as a function of sample.

5. Before shutdown, Picarro recommends flowing clean dry air (CDA)
through the analyzer for several minutes. This prevents moist gas in
the cavity from condensing on the optics as the analyzer cools.

22 P/N 40-0012 Rev. E G5310 User Manual
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7. INSTALLATION

This section describes the setup and installation of the Picarro Analyzer. Please
read and understand this section thoroughly before proceeding with the
installation.

This unit is designed to be used in an indoor environment. Do not
operate or store the unit outside or exposed to the elements.

>

WARNING

Do not attach electrical power to or start the analyzer until after
attaching and turning on the External Vacuum Pump. Do not
disconnect the vacuum line while the analyzer is running. Failure to
WARNING  do so could result in damage to the optics.

>

Picarro sells USB enabled devices, such as GPS, which is
approved for use. Please do not connect USB hubs or unapproved
USB devices, other than flash drives to the computer because they
WARNING  can interfere with the operation of the analyzer.

>

If rack mounted, the Analyzer cannot support itself using a front
rack mount kit alone. The instrument must be supported by a shelf
or additional rails attached to the rack.

>

WARNING

If the analyzer has been stored at less than 10 °C, allow the
components to equalize to room temperature before starting the
installation process.

>

0
>
(@
4
o
z

Analyzer is for indoor use only and has an ingress protection rating
of IPx-0. Analyzer is NOT protected against exposure to water
including dripping, spraying, splashing or immersion.

>

0
>
(@
4
o
z

When the analyzer is being integrated to an external system, the
safety of that system is the responsibility of the assembler of that
system.

>

CAUTION
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CAUTION

%

NOTE

CAUTION

7.1

A\

WARNING
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During installation and operation, do not position the analyzer so
that it is difficult to operate the disconnecting device.

Take care to ensure that warm air is exhausted from an enclosure
in which the analyzer is mounted.

It is imperative that the analyzer have adequate ventilation and/or
cooling to maintain the ambient temperature below 35 °C when
operating. Failure to provide adequate airflow, especially clearance at
the front and rear panels, to ensure proper airflow and/or cooling to the
analyzer will result in overheating of the analyzer causing a shutdown
and potential damage. There should be 4” (10cm) of clearance in the
front and back of the analyzer.

Thermal

Specifications Min Max Description

Worst-case environmental
10 =C 35°C | limits (unless otherwise
specified)

Ambient Operating
Temperature

Analyzer and Vacuum Positioning

1. Remove the Analyzer and Vacuum Pump from the shipping
container. This requires two persons for lifting the hardware.

This analyzer weighs 75 Ibs. (34 kg). Use the technique outlined in the
General Safety section on page 15 when lifting or moving the analyzer.

2. Place the Pump unit on a bench top or flat surface. Place the
analyzer on top of the pump. Don’t push the analyzer/pump into
position yet; there are cables to be installed on the back panel.
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Figure 9: Analyzer
Type
description
here
PICARRO
Power
indicator gosr?
soft On/Off
Pump power |
indicator

Pump

3. Unpack the analyzer connection accessories. The Certificate of
Compliance and USB drive should be stored in a safe place and
may be required if you contact Picarro with questions about your
analyzer.

7.2 Connections

Figure 11 shows the analyzer rear panel with the connections labeled. The
numbered steps in the following steps correspond to the numbered list
below.
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Figure 10:
Rear panel
connections

1. Connect the vacuum hose to the top box.
2. Connect the free end of the vacuum hose to the bottom box.

Equipment Damage: Never disconnect the vacuum hose unless the
A pump and analyzer are OFF, otherwise the system may be

WARNING damaged.

Connect the inlet from the analyzer to the sample line.
Connect the 25-pin cable to the analyzer.
Connect the 25-pin cable to the bottom box.

o ok w

Leave the exhaust port open to the atmosphere.

Use the AC power cables supplied with the analyzer or a similarly
rated cable. Check with Picarro technical support if you have
guestions about power cable replacement. An inadequately rated

CAUTION power cable can result in equipment damage.
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CAUTION

B

NOTE

NOTE

7.3

WARNING

Cords shall be RATED for the maximum current for the equipment
and the cable used shall meet the requirements of IEC 60227 or IEC
60245. Cords certified or approved by a recognized testing
authority are regarded as meeting this requirement. The connector
type used should be: IEC320 C13.

7. Connect power cord to the top box.
8. Connect the power cord to the bottom box.

9. Make sure the 110/220 SELECT switch on the bottom box is
configured properly for your region.

10.Connect a keyboard (included), mouse (included), and monitor (not
included) to the computer connectors on the top box.

This device will operate under its default settings without any direct
control of the internal software.

11.This switch is used for customers who may want to use external
pumps.

When the switch is in the ON position, the internal vacuum pump
activated.

When the switch is in the OFF position, the internal vacuum pump
will remain off even when the analyzer is turned on.

The software to operate the instrument will start automatically after
the operating system has loaded. The user interface will appear a
few seconds after the instrument software starts. See “Startup
Procedure” in Section 8.1.

Connecting to the Analyzer Inlet

Connect to the inlet of the analyzer using %" OD PTFE or PFA tubing using
the supplied plastic ¥2" PFA inlet nut and ferrules.

When using compressed gases, follow all appropriate safety
conventions, including use of eye protection, physical restraint of
cylinders, etc.

Making a New Connection:

When using new tubing, follow these steps.
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1. Place the two ferrules inside the nut as shown.
Figure 11:
Orientation of
ferrules and nut E E
2. Loosely connect the nut to the INLET on the back panel of the
analyzer about a full turn, being careful not to let the ferrules fall out.
3. Insert the tubing into the back of the nut, feeding it in as far as

28

possible without deforming the tubing.

4. Hand tighten the nut.

Using a 5/8" wrench (not included), tighten the nut approximately
seven flats (420 degrees).

Replacing a Connection

When reattaching tubing that already has a nut connected:

1.

Inspect ferrules. If you see any damage, replace the ferrules and
follow the directions above for making a new connection.

If there is no damage, hand tighten the connector to the analyzer’s
INLET.

Using a 5/8" wrench (not included), tighten the nut approximately
one flat (60 degrees).
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8. ANALYZER BASIC OPERATION

8.1  Startup Procedure

This section describes the steps to power on the system. These steps are
sufficient for operating the instrument.

1. Switch on the main power to the analyzer at the rear panel.

Figure 12: On/Off Switch

Main Power

2. Press the soft power button located on the front panel. The software
will start automatically, and the analyzer will display the CRDS Data
Viewer window. Data Viewer features are detailed in Section 9.

3. Wait approximately 45 minutes for the system to power, initialize,
and stabilize.

4. Once the cavity pressure and operating temperature are at their
proper setpoints and stable, the analyzer will start measuring.

As the instrument is starting up, it is normal for there to be a delay in

reporting data. This can take several minutes depending on how long it

takes for the internal temperature and pressure to reach their operating

points, and it is normal during this time for some concentration readings to
@ be negative or constant.

NOTE The data selection pull-down menus will not be populated with the
appropriate items until actual data is being reported in the graph. This is
typically less than 30 minutes, but depending on ambient temperature, the
analyzer can take up to 1 hour to stabilize.

5. Select N20 from the Data Key dropdown menu in the CRDS Data
Viewer screen. Figure 14.

6. Restart the analyzer: double-click the Picarro Mode Switcher icon
on the desktop and select Isotopic N20.

If you get logged off of Windows at some point, the username you
log into is Picarro and Password: Extreme_Science!
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Figure 13:
Picarro
Analyzer GUI

Data Buffer
Level Meter

Reset Data
Buffer

Data Window

8.2  Desktop Icons and Folders

On the Windows™ desktop, there will be the following icons and folders:

1. Start Instrument: When clicked, the analyzer will start measuring in
the configuration that it was in when the software/analyzer was shut
down.

2. Coordinator Launcher: Depending on the system’s configuration,
the coordinator program may not be included. Clicking on this icon
will lead you to a window that will allow you to choose the proper
coordinator to operate the peripheral module that came with your
analyzer.

3. Picarro Mode Switcher: When clicked, you will be led to a window
that will allow you to switch between various measurement modes.
Most analyzer models are configured for one mode and may not
include the Mode Switcher. If the analyzer has multiple modes, this
allows the user to switch between them easily.
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Figure 14:
Picarro Mode
Switcher

Picarro Mode Switcher

Select Measurement Mode

Ethane & Methane Concentration

Copyright Picarro, Inc. 1993-2016

4. Picarro Controller: When clicked, you will be led to a useful
diagnostic panel allowing the user to see the analyzer’s internal
temperatures, pressure, and spectroscopy in real time. This
program has user-accessible functions, but it cannot change
anything related to analyzer functionality. It is intended for diagnostic
purposes only.

5. Picarro Utilities Folders:

a) Data file Viewer: When clicked, you will be led to a window
that will allow you to convert between *.dat and H5 data files
and to make various graphical representations of your data.
The instructions on using the Data File Viewer software are
described in the Appendix B

b) Data Recal: When clicked, you will be led to a window that
will allow you to recalibrate your data based on known,
certified data.

c) Setup Tools: When clicked, you will be led to a window that
will allow you to edit various settings for your analyzer (See
the Setup Tool section of this manual for information about
these settings).

6. Diagnostic Folder

a) Stop Instrument: When clicked, you will be led to a window
that will allow you to turn off the analyzer in an emergency
event. Upon clicking on this icon, the following window will
pop up. Please see Shutdown Procedure on page 32 of this
manual to shut down the analyzer in normal circumstances.
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Figure 15:
Stop CRDS
Software

CAUTION

CAUTION

8.3

32

I Stop CRDS Software

Stop CRDS Software

Select shutdown method
{% Stop software buk keep driver running

{~ Stop software and driver

" Turn off analyzer in current state

Skop

EXCEEDING GAS INLET PRESSURE OR TEMPERATURE
SPECIFICATIONS COULD RESULT IN DAMAGE TO THE
INSTRUMENT. In the case of higher input pressure or flow,
configuring a sampling bypass manifold system is recommended.

Use a ‘tee’ at the gas inlet and either return the remainder to the
main gas stream or exhaust appropriately.

Do not disconnect the AC power to the analyzer, vacuum line or the
AC power to the External Vacuum Pump while analyzer is
operating. Damage may be caused by current surges if power is
applied while attaching or removing cables.

Shutdown Procedure

To shut down the analyzer using the GUI:

1. Click on the “Shutdown” button located on the left side of the Data
Viewer window.

2. A window will pop-up prompting the user to confirm the shutdown.
Once confirmed, the analyzer software and hardware will turn off.

The analyzer shuts down:

3. Cauvity fills with gas from the inlet until it reaches near atmospheric
pressure.

4. Status log shows the pressure as the cavity is filled.
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5.
6.
7.
8.

Proportional valves close.
Software shuts down.
Analyzer powers off.

When the soft shutdown is completed, shut off the main power using
the power switch on the back panel.

A flow of clean, relatively dry gas should always be directed to the

instrument for several minutes prior to shutting down. Trapping a
high-moisture content gas sample in the cavity can cause
CAUTION condensation damage to the mirrors as the instrument cools from

its operating temperature.

Do not turn off the pump or disconnect the vacuum line while the
instrument is operating.

CAUTION

FOR G2xxxx ANALYZERS: If you have trouble turning off the
analyzer software, do not kill the process(es) in the task manager;
rather, double-click on the "Stop Instrument” icon in the

CAUTION Diagnostics folder on your desktop.

Figure 16: —_————
Shutdown Analyzer shut Lown 3%

Window

Do you really want to shut down the analyzer?

CAUTIOMN: & flow of clean, relatively dry gas is required to be directed
through the instrurment for 5 minutes prior to shutdown,

Fail to flush and vent cavity with clean dry gas may cause mirror
contarnination, leading to fatal instrument failure!

Yes Mo
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8.5  Recovery from Electrical Power Outage
When the power returns after an unplanned outage, the analyzer restarts
automatically. The Picarro software:
¢ Closes files that were interrupted by the power outage.
e Opens new files for data collection.

o Data, analyzer diagnostics and other parameters recorded up to the
time of power outage are retained.

If short power outages will be a routine operating environment, Picarro
recommends using power conditioning or an uninterrupted power supply to
help prevent damaging operating system and software corruption problems
that can occur with repeated crashes.
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9. LIST OF GUI FUNCTIONS

9.1  GUI Overview
The features of the Picarro analyzer GUI are identified in Figure 18 and
described in the following sections.
Figure 17: e
G5310 GUI PICARRO Carbon Monoxide and Nitrous Oxide Analyzer
Data Viewer R —
Alarm Panel ____
Digital Readouts = _nou:-“m
| Reset Data
Buffer
Data Log File __
Name and Path
9.2  Settings, Tools, and Help Menus
Settings Menu
Left clicking on the Settings menu pulls down a menu that has one entry
‘Change GUI Mode from Standard to Service.’ This is the access point to a
password protected service mode where additional operational and
measurement parameters are displayed. Selecting and clicking on this
entry opens the Cavity Ring-Down Spectrometer Controller. This is
reserved for Picarro service operators only.
Figure 18:

Settings Menu

'K
[Settings Wiew Tools  Help

Change GUI mode from Standard to Service
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View Menu
This menu item has three entries:

Figure 19: [ ata Viewer
View Menu Settings [Wiew | Tools Help

Lock time axis when zoomed

P Show Statistics

Show Instrument Status

1. Lock/Unlock time axis when zoomed: When locked, forces the two
graphs to display the same time scale during zoom.

2. Show/hide statistics: Toggles the measurement statistics display,
see Digital Readouts section on page 41 below.

3. Show/hide instrument status: Toggles the status of the instrument

display.
Tools Menu
This menu item has two entries:
Flgure 20 i ata Wiewwer
Type Sethings  Wiew Im] Help
description User Calibration
F[)]ere P I ( ShowHide WValve Sequencer GUI
1. User Calibration: Opens the user calibration window (default
password is “picarro”). The password can be reset in the
QuickGui.ini file in the instrument directory:
“C:\Picarro\G2000\AppConfig \Config\QuickGUI\" under the section:
[Authorization] UserCalPassword = Picarro Show/Hide Valve
2. Show/Hide Sequencer GUI: Toggles the display of the external
valve sequencer window.
The calibration slope and intercept can be entered, and their effects
immediately were seen in the data. Please refer to the Calibration
Section on page 63.
Help Menu

3. About: Displays the version number of the instrument.
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9.3 Alarms Panel

Figure 21: Alarms
Alarms Panel = System Alarm
=l IPV Connectivity
= N0
= H20
= co2

This panel is used to monitor the status of the internal instrument alarms.
These indicators are gas concentration alarms, such as “N20 Too
High/Low” depending on instrument configuration. The gas concentration
alarm LEDs are off (grayed) when the respective concentrations are below
a certain value, and they are illuminated when the respective
concentrations are above/below a certain value.

To view the alarm set point, click on the LED and a dialog box will appear
indicating the alarm setting and allow the user to enable it or change the

setpoint:
Figure 22: Setting alarm 1 =x=
Alarm Setting Alarm name NoO
Window

Alarm is set when value is above Alarm
threshold 1. It is reset when value falls
below Clear threshold 1.

Alarm threshold 1 100.00
Clear threshold 1 95.00

Alarm threshold 2 ‘UUO—|

Clear threshold 2 ‘E

Enable alarm

| ok || cancel |

Type the value you wish to set the alarm to and press the “OK” button, or
press “Cancel’ if you do not wish to change the alarm value. If you do
nothing, the dialog box will disappear, and the alarm value will remain
unchanged.
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9.4 Instrument status

If these parameters are enabled through the ‘Show Instrument Status’
entry in the ‘View’ Menu on the main toolbar digital readouts for Warm Box
temperature, Cavity Temperature and Cavity Pressure are displayed to the
left of the main trend graphs.

F'gure 23: Instrument Status
Instrument Warm Box T o
Status arm Box Temp (*Ch
Cavity Temperature ("C)

Cavity Pressure (Torr)

9.5 Data Log Filename and Path

The filename and path of the active data log are displayed in this pan. The
indicator is grayed-out if there is no active data log (i.e., if a new data log
has not been started using the Start /Stop New Data Log Button). A new
file will be generated at midnight, which will be saved to the same location

as the original log file.

Figure 24:
Data Log
Filename

9.6 Data Window

The data window displays a graph of any stream of data vs. system time,
with a format of hh: mm: ss. The user can select which data stream is
displayed using combinations from the Data Source and Data Key pull-
down menus. The precision displayed can be adjusted using the
“Precision” menu and Auto-scaling of the ‘Y’ axis is also available.
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Figure 25:
Data  + (Data Key 2) Top Data Plot
Window : : (Data Key 1)
Middle Data Plot
(Data Key 2)
Bottom Data Plot
(Data Key 3)
Source Keys Data Keys Precision  Autoscale Reset Buffer
Data Source and Data Key Pull Down Menus
These two menus enable selection of the data stream that is viewed in the
data window. Data streams available on the GUI are gas concentrations, if
‘instrument Analysis’ (where instrument represents the system installed) is
selected, or if “sensors” is selected, the analyzer’s optical cavity pressure
or temperature can be viewed as well as the nominal ambient temperature
of the analyzer (“DAS temp”) and the temperature of the analyzer’s
electronics chamber, indicated as “warm chamber temp.”
Figure 26:
Source and Data |~ TopPlet Left-click on the
Key Pu"_Down Middle Plot arrow to select
Menus Bottom Plot solrce species
Precision Pulldown Menu
Click on this icon to select the precision displayed on the y-axis, between 0
and 4 digits of precision or “auto.” The currently selected precision is
displayed during operation. This does not affect the precision of the saved
data in the data log files or results files.
" recion Auto-scae
Precision sl
Pulldown
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Figure 28:
Data Buffer and
Reset Buffer

40

Data Buffer Level Meter

The meter to the right of the Data Window indicates how much of the
internal memory of the GUI is used to retain historical data collected with
the instrument. There is an internal limit of a finite number of points. Once
that number of data points is collected, the buffer is full, and old data is
removed from the buffer as new data is collected. This buffer affects only
the data displayed in the data window, not the data stored in any files. This
buffer is empty upon instrument startup and can also be emptied by
pressing the reset data buffer button in the lower-right-hand corner of the
GUL.

Data-Buffer
level meter

Reset buffers
Button

Reset Data Buffer Button

Press this button to clear the internal data buffer of the GUI (this clears the
current data traces from the graphs). This has the effect of clearing all data
in the data window. Pressing this button has no effect on any of the data
log files stored by the instrument.

Graph Zooming

To zoom the graph, simply drag the magnifying glass over the section to be
zoomed and click and hold the left mouse button. While holding down the
left button, move the mouse to create a box that covers the region of
interest. When the box is properly drawn, release the left button and boxed
area will automatically scale to fill the data window. To zoom back out,
double-click on the left button. To auto scale, the y-axis of either graph, use
the auto-scale buttons below the graph. To lock or unlock the time axis of
each graph during zooming, select that menu item in the ‘View’ menu.
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Figure 29:
Graph Auto-scale ¥
Zooming Auto-scale Y

Digital Readouts

Displays the latest value recorded for the selected Data Key for each Data
Window. Changing the Data Key modifies the Digital Readout as well as
the Data Window view. If the ‘Show Statistics’ entry is enabled in the ‘View’
menu, the mean, standard deviation and slope of the data in the graph are
dynamically calculated and indicated below the digital concentration
readout. These numbers change to reflect statistics of whatever data is in
the data window.

Figure 30:
Readout r;g';‘:mt o
---
co co
digital s
readout me 1k oo
---
H,0 H20
readout mew  MOer sloge
L SR -

Start / Stop Data Log Button

The Analyzer automatically records all data collected on the instrument and
saves it for later analysis. These files are called Data.dat files, which are
described below in the section called File Management. In addition, the
user can record a separate data log file. Press this button if you would like
the instrument to start recording a separate data file. A dialog box will
appear prompting you for a filename and location. Press this button again
to stop recording the data file.
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9.8  Status Log Window

This window displays instrument status messages, in the following form:
“‘MM/DD/YYYY hh: mm: ss generic message text.” These messages
include all messages sent to the DAS front panel display. The common
status log messages are:

4. Temperature Locked: WB (HB)

The system waits for the warm box (“WB” — the temperature-
controlled electronics and wavelength monitor chamber) to reach
operating temperature. Similarly, the temperature of the hot box
(“HB” — the temperature-controlled chamber containing the
analyzer’s optical cavity and gas handling system) is stabilized. This
is typically the longest step in the startup sequence. The duration of
this step can range from 5 to 60 minutes, depending on the ambient
temperature and how much time has elapsed since the last startup.

5. Entering Measurement

Spectral scanning has started. Concentration measurements will be
available in approximately 30 seconds. The instrument will continue
to scan and report concentration measurements until the instrument
is shut down using the procedure below.

6. Pressure Stabilizing/Locked

The valve control system begins to allow flow through the analyzer
and stabilizes the pressure inside the cavity.

7. Measuring

This is the normal mode of operation after startup has completed.

Figure 31:
Status Log
Window
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10. MAINTENANCE

Picarro analyzers require minimal service or maintenance. With the exception of
the particulate filter, and refilling the chiller, and replacing fuses, the analyzer is not
user serviceable.

Before performing any maintenance shut down the analyzer.

10.1 Cleaning

Clean the outside of the analyzer with a clean dry cloth. Users should
never access or clean the inside of a Picarro analyzer.

10.2 Fuse Replacement Procedure

Fuse replacement can be performed by users. The analyzer uses a 1.5A at
250 VAC, 5mm x 20mm, slow blow fuse. Follow this procedure to replace a
fuse. Figure 33 shows the fused power connector on the lower right corner
of the PPU rear panel (Figure 33).

Figure 32:
Type
description

here Fuse

Housing

Before replacing a fuse, make sure that the analyzer power is off
and that the power cord is disconnected.

WARNING

1. Insert a screw driver flat head under the tab on the fuse housing.

2. Carefully push the screw driver handle away from you to lever the
fuse housing out of the analyzer back panel.

3. Remove the fuse from the fuse housing as shown in Figure 34.
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Figure 33:
Fuse
Replacement

10.3

WARNING

44

Fuse Holder

4. Put a new fuse in the fuse holder.

5. Push the fuse holder into the rear panel. You will hear a click when it
is fully inserted.

Particulate Filter Replacement

Gasses are filtered by two in-line, sub-micron particulate filters before the
reaching the measurement cavity. The outer filter is user-replaceable.
Replacement filters can be purchased from Picarro and installed by users.
This section describes outer filter replacement.

The inner filter is NOT user replaceable. Do NOT open the hot box.
Inner filters must be replaced by a Picarro certified technician.
USER REPLACEMENT OF THE INNER FILTER OR BREAKING THE
ANTI-TAMPER TAPE ON THE INNER FILTER VOIDS THE
WARRANTY.

Symptoms of a Clogged Filter
Filters can become clogged with continual use.

If liquid water is sucked into the inlet line, it may clog the filter and impede
the flow (usually for a few days) until it evaporates.

Some symptoms of a clogged filer are:
e The analyzer pressure is low.
¢ Low flow into the analyzer, causing unusual measurements.

e Response time is slower than usual.
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Solutions

Do NOT turn off the analyzer when a filter is wet or replace a wet filter.
Liguid water in the filter can cause condensation on the optics if the
analyzer is allowed to cool when the filter is wet.

Dry the filter by running Clean Dry Air (CDA) through the analyzer. If the
analyzer functions normally after drying, a filter replacement is not
necessary.

If drying the filter does not fix the problem, replace the filter.

Tools Required

Make sure you have these tools before starting the filter replacement:

9/32 nut driver

’Ig” open-end wrench
%/16” open-end wrench
Needle-nosed pliers

1.5 mm hex wrench

Figure 34:
Tools Required

Phillips Screw driver %‘
5% Open End irench M

11116 Open End Wrench 3—0

6 Open EnWrench ) E——)
1.5mm Hex Wrench ———"’J

Particulate Filter Removal

1. Move the analyzer to a clean environment.

2. Using the 2mm hex driver, remove analyzer top lid by removing six
(3 per side) M3 x 6mm socket flathead screws.

3. Lift the top cover off of the analyzer.
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Figure 35: Remove the Foam

Foam Removal ,,\(

Filter

Figure 36:
Filter Exposed

5. Loosen the filter output nut. (Fig 37)

Figure 37: Loosen Nut
Type
description
here
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7. Remove the screws that secure the inlet bulkhead (Fig 38).
8. Pull out the Inlet bulkhead with filter still attached.

Figure 38: Remove Screws
Remove ;

Bulkhead

Screws

9. Remove the filter from the inlet bulkhead by loosening the attaching
nut.

10. Attach new filter in the correct orientation (observe flow arrow
direction). Installation is the reverse of removal.

11.Using the ’/8” wrench, loosen the retaining nut on the input
bulkhead (about 1 full turn should be enough).

12.Pull up on the filter cover and slide it towards the right side of the
analyzer to remove it.

10.4 Laser Chiller Service

The analyzer is equipped with a chiller (40ml water buffer tank) for laser
cooling. Figure 40 shows the buffer tank.

e The recommended coolant is from Koolance, PN # LIQ-702. Itis a
solution of distilled water and propylene glycol.

e The buffer tank is filled with coolant when shipped. Refill or add for
cases when empty or at a low-level.

o Make sure there aren’t any kinks / twists in the exposed coolant tubes,
especially during an analyzer’s installation or after a relocation.

¢ Instrument must be powered off before connecting coolant tubes and
the initial fill or drain of buffer tank. One may leave the analyzer on
when refilling a tank with low coolant using the two ports on top of the
tank’s lid.
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e Picarro recommends inspecting the coolant level in the buffer tank and
adding or refreshing in case of coolant loss or contamination.

e Coolant consumption is dependent on many factors. Recording the
frequency for coolant maintenance can be helpful.

Buffer Tank Initial Coolant Fill

Following is a procedure for the initial fill of the buffer tank:

1. Seat the analyzer's main box and PPU on a table.

2. Inspect buffer tank for possible crack and/or external tube breakage.
Repair before filling.

Figure 39:
Chiller Buffer
Tank

3. The black top lid of the buffer tank should sit slightly higher than the
top of main box. Adjust tank level, if necessary.

4. Remove the black top lid by turning counter-clockwise. Fill the buffer
tank with coolant until full; secure top lid to seal the tank. On top of
the lid, are two ports, which can also be used to fill and refill tank.

Figure 40:
Filling the
Buffer Tank

48 P/N 40-0012 Rev. E G5310 User Manual



PICARRO

5. Disconnect the quick connectors from each other, as they are
shipped plugged into each other. Then plug them into the two quick
adaptors at the bottom of the buffer tank, as shown in Figure 42.

Figure 41:
Buffer Tank
Connections

Connectors

6. Power on the analyzer to check the coolant flow. In a normal
operating condition, coolant will be visible inside the tank. If
necessary, add more coolant to buffer tank.

Refilling the Chiller

In the event coolant level is below the minimum level marker on the tank, a
refill is necessary.

1. Analyzer can be ON or OFF for this operation.

Perform Step 4 of initial coolant fill.

Turn on analyzer to circulate coolant in tank for 5-10 minutes.
Check level and flow. Add more coolant if necessary.

a M D

If coolant is contaminated, turn off analyzer, drain buffer tank, and
reconnect the tubes, before performing Steps 2 - 4.
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11. TROUBLESHOOTING

This section lists problems that may occur during installation and operation of the
analyzer, and step-by-step procedures that will provide resolution in most cases. If
these instructions do not solve the problem, contact Picarro Technical Support.

11.1 Power LED on Analyzer Does Not llluminate

Pressing the front panel ON button does not start the analyzer. The green
power LED is normally illuminated when the analyzer is on.

1. Check that the AC power cord is attached and plugged into a
working outlet.

2. Check that the rear ON-OFF switch near the AC power cord is in the
ON position.

3. Press and hold the front panel power switch for at least 5 seconds
as the analyzer may take several seconds to respond.

11.2 GUI Does Not Display at Start-Up

The computer may be configured to either:

e Automatically start the analyzer and GUI after it completes its boot-up
sequence

e Launch the GUI using the Start Analyzer icon on the desktop
To configure the computer:

1. Shut down the analyzer by shutting down Windows on the on-board
computer.

2. Wait for the shutdown to complete normally and for the computer
and analyzer to turn off completely.

3. After a few seconds, restart the computer by momentarily pressing
the power button on the front panel. See Figure 6 for the location of
the front panel power button.

Do not restart windows without cycling the power to the analyzer.
Restarting windows will not fix this problem.

CAUTION
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11.3 Cavity Pressure Cannot be Adjusted for Concentration
Measurements

The cavity pressure is automatically locked to the correct value during
normal operation.

The Pressure Locked message on the on the lower left corner of the GUI
indicates that the cavity pressure is within operating parameters. See
Figure 43.

Figure 42:
Status Log
for New Filter

MN20 Analysis
CO Analysis

HZD Analysis

Pressure locked and
unlocked message

If the cavity pressure is out of operating specification the GUI displays a
Pressure high or Pressure Low message.

1. The Pressure Low message on the GUI indicates that there is
insufficient gas available at the analyzer gas inlet.

a. Check the inlet plumbing to the analyzer.
b. Ensure that the pressure at the inlet is within specifications.

2. The Pressure High message on the GUI indicates that gas cannot
exhaust from the analyzer at a sufficient rate.

a. Check the vacuum line between the analyzer and the power
vacuum unit for leaks.

b. Check the vacuum pump. Make sure it is functioning
correctly.

c. Check the gas pressure inlet for excessive pressure.
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11.4 User Interface Program Does Not Update Graphs as
Data is Collected

The computer may become unresponsive causing the programs that
control the analyzer to stop functioning. If this happens:

Shut Down the Computer

If the computer responds to the mouse, do a normal Windows shutdown
from the Windows start menu:

1. Wait until the computer is completely shut down.
2. After a few seconds, start the computer using the power button.
If the computer does not respond to the mouse:

1. Hold down the power switch on the front panel for a few seconds
until the computer and the analyzer turn off.

2. After another few seconds, restart the analyzer using the power
button.
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12. FILE MANAGEMENT

Wom w8 e

The analyzer generates ASCII-format text output files. Data files are created every
15 minutes by default.

The file name is generated from the analyzer serial number, the date, and the time
when the analyzer was started. For example:

Instrument
Serial Number Diate Time (GMT)
| 1

'JKADS 2001-20160127-1029-DataLog_User_Raw.dat

JKADS2001-20160127-1029-DataLog_User_Raw.dat
JKADS2001 is the analyzer serial number

20160127 is the date, 1/27/2016, in format yyyymmdd (to allow chronological
sorting of data files).

1029 is the time the file was started in GMT, 10:29 am, formatted as hhmm using a
24 hour clock.

The raw user data is contained in folders in the directory:

e C:\UserData \DataLog_User\year\month\day\hour. (for data that has
been sampled at the analyzers native sampling rate).

e C:\UserData\DataLog_Sync\ month\day\hour (for data that has been
sampled at a constant rate.

Data files are created every 60 minutes and stored for 90 days (default for SADs
analyzers) before they are automatically deleted. File deletion frequency and
details can be modified in the file:
C:\Picarro\SI2000\AppConfig\Config\Archiver\Archiver.ini. See File Archival and
Automatic Deletion of Old Files.

During data acquisition, the analyzer creates directories to store the data, filed by
the date the data were acquired.

The figure below shows a partial example of a data file.

DATE TIME FRAC_DAYS_SINCE JAN1 FRAC_HRS_SINCE_JANL JULIAN DAYS EFOCH_TINE ALARM_STATUS
2016-10-15 00:24:44.483 287.68354818 6904, 412357 288.68384819 1476491084, 484
2016-10-15 00:24:46.444 287.68387089 6904, 412901 288. 68387089 1476491086, 445
2016-10-15 00:24:48.415 287.68389370 6904, 413449 288. 68389370 1476491088, 416
2016-10-15 00:24:50.385 287.68391650 6903, 413996 288. 68391650 1476491090, 3586
2016-10-15 00:24:52.355 287.68393931 6904, 414543 288.68393931 1476491092, 356
2016-10-15 00:24:54.335 287.68396222 6904, 415093 255. 68396222 1476451054.336
2016-10-15 00:24:56.309 287.68398506 6904, 415641 255. 683958506 1476451036 .309
2016-10-15 00:24:58.246 287.60400748 6904, 416179 258.60400748 1476451055.246

cocoooooa
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Datafiles are closed every 15 minutes and moved to an archive directory and a
new datafile is started.

The archive directory is C:\Picarro\ G5000\Log\Archive\ and has subdirectories
DataLog_Mailbox, DataLog_Private and DataLog_EventLogs with files arranged
by year\month\day\hour.

There are more complete data files which include additional information beyond
the concentration data including parameters such as analyzer temperatures and
pressure, setpoints and spectroscopic information. This information is generally not
useful to the user, but can be useful for diagnostic purposes and is store in the
directory C:\Picarro\ G5000\Log\Archive\DataLog_Private \year\month\day\hour.

For more information about how to include various columns of data from the
DatalLog_Private in the C:\UserData Datalog files, contact Picarro.

The currently active data file can be found in C:\Picarro\ G5000\Log\DataLogger\.

Archive directory contain subdirectories arranged by file type and internally
organized by \year\month\day\hour.

To keep the data files easy to manage and to limit the size of individual files and
directories, new files are automatically generated whenever the analyzer is
operating.

The software automatically generates new files each time the analyzer is powered
up and also at midnight (GMT) each night. When new files are created at midnight,
their file name will contain the new date and a time of 00:00.

For example, if the system was started at 10:29 am on 2/5/2016 it would create a
file named 20160205\S

JKADS5310-20160205-1029-UserLog.dat. Then at midnight a new file will be
created -20160206-0000-UserLog.dat.

12.1 File Archival and Automatic Deletion of Old Files

The analyzer can automatically compress (zip) and archive old files as
mentioned above. This operation is controlled by the ini file:
C:\Picarro\G5310\AppConfig\Config\Archiver\Archiver.ini.

For each file type, there are various items along with some recommended
default settings which may vary by file type:

Directory = C:/UserData/DataLog_Sync

Optionally specifies which directory to find files to archive.
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MaxCount = -1

Specifies how many files to keep. A setting of -1 indicates that there is no
maximum number of files. Generally, -1 is used in conjunction with a
maximum size limit, below.

MaxSize_MB = 1500

Specifies that a maximum of 1.5 GB of data is to be kept before the system
begins to delete old data.

Compress = True/False

Specifies if archived files are to be zipped — recommended setting is true to
save hard drive space. True means files are zipped, false means files are
not zipped.

AggregationCount =0

If compression is set to TRUE, specifies how many files to be included in
each zip archive.

StorageMode = FIFO
First in first out. Specifies that old data is deleted first.
Quantum =4

Generally, should not be changed. Specifies the files be sorted by
year\month\day\hour in the archived directory structure.

In addition to the automatic file and directory management described
above, the analyzer also automatically deletes various files specified in
C:\Picarro\ SI2000\AppConfig\Config\FileEraser\FileEraser.ini. There are
various settings, as described below:

runtime_interval_hrs = 0.5

Specifies how often (in hours) to run the file eraser.
path = ../../../Log/Archive/DataLog_Private
Specifies which directory to look in for files to delete.
extension = dat

Specifies which files having what extension are to be deleted. If empty, it
deletes all files.

delete_time_hrs =48

Specifies how long to keep files prior to deletion.
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12.2 Setup Tool

In the desktop folder called Picarro Utilities, the Setup Tool can be
launched by double clicking on its icon. The tool allows the user to
configure data file saving details, including which data elements are written
to data files, digital data output (via serial port or TCP/IP), remote data
delivery (via email), and general GUI properties.

Data Logger

The Data Logger tab allows the user to configure various data file saving
details, including which data elements are written to data files.

Data Columns: Controls which data elements are written to data files.
Hours of Each Log File: Controls the size of each data document.

Enable Mailbox Archiving: Enables archiving of data in the mailbox
folder: C:\Picarro\G2000\Log\Archive\DataLog Mailbox

Archived Directory Structure: Specifies part of naming convention for
data documents.

Total User Log Storage Size (GB): Specifies the size of storage
allowed for User Data (Recent Data).

After making the appropriate edits, click “Apply” to put changes into effect
and then “Exit” to close the window.

Figure 43:
Data Logger
Setup Window

M picarro Analyzen Setup Tool (Flux)
Settings  Help

| Datalogger | PorcManager | DataDelvery | GUIPropertes | ConmandInterface | DataStreamng | Electrical Interface

Data Logger Setup

Data Columns (Datalog_User_Sync) | CavityPressure_sync Al

Hours of Each Log File (0.01~24) | 1

Enable Mailbox Archiving I3

Archived Directory Structure [VEAR] MONTHY DAY |
Total User Log Storage Size (GB) |3u ;I

Data Columns (DataLog_User) | cavity_pressure A

Hours of Each Log File (0.01~24) [os

Enable Mailbox Archiving |2

Archived Directory Structure IVEARf MONTH[ DAY LI
Total User Log Storage Size (GB) [a0 =

Get Complete Data Calumng |
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Serial/Socket Port Manager

The Port Manager tab allows you to control digital data output/Input via
serial port or TCP/IP.

e Data Streaming: specify the port for data streaming
(COM1/COM2/0ff)

e Valve Sequencer MPV: specify the port for connecting to Valve
Sequencer (COM1/COM2/0ff)

e Command Interface: specify the port for Command Interface
(COM1/COM2/ TCP/Off).

Make sure there are no COM port conflicts before clicking “Apply.” After
making the appropriate edits, click “Apply” to put changes into effect and
then “Exit” to close the window.

Figure 44:
Serial/Socket
Port Setup
Window

M Picanro Analyzer Setup Tool (Flux)

Settings  Help

| Datalogger | Port Manager | DataDelivery | GUIProperties | Command Interface | DataSireaming | Electrical Interface |

Serial / Socket Port Manager

Data streaming -

Valve Sequencer MPV |coM2 ;l
=

Command Interface |Tcp
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Data Delivery Setup

The Data Delivery tab allows the user to schedule remote data delivery via
email.

e Delivery Start Time: Time of the day when data will be sent.

e SSL: Depending on the sender’s email server, the sender can
activate the Secure Sockets Layer (SSL).

e Use Authentication: Turning this on will require the receiver to
provide a password and a username to access data. Set up the
password and Username from this window.

e From: Sender’s email

e To: Receiver’'s email.

e Subject: subject line of the email.

e Data Directory: Location of the data you want email.

After making the appropriate edits, click “Apply” to put changes into effect
and then “Exit” to close the window.

Fl g ure 45 M Picarro Analyzer Setup Tool (Flw)
Settings  Help
Data Dellve ry | Datalogger  PortManager | DataDelivery | GUIProperties | Command Interface | DataStreaming | Electrical Interface |
Setup Window Data Delivery Setup
Delivery Start Time |ou:ou:05 :’
Use SSL e ~|
Use Authentication [uo |
Server [ wondstock.blueleaF.com
User Name [alee
Password [1224
From |
To | ewahl@picarro.com
Subject |
Data Directory | 2 [Picarra/G2000/Log ArchivefDatalog_Mailbox
| Data Directory I
Stop Delivery Scheduler I
Get Default Configurations I
R
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Editing Main GUI Properties

The GUI Properties tab allows you to set the number of line graphs visible
on the main GUI.

In this tab, you can enable control of a connected Valve Sequencer from
the main GUI:

3. Click on “Settings” of the “Setup Tool” window, and then “Switch to
Service” mode.

4. Choose “Yes” next to “Enable Control Valve Sequencer” drop down
menu on the “GUI Properties” tab.

5. Click “Apply” to put changes into effect and then “Exit” to close the
window.

You should now be able to access the “Show/Hide Valve Sequencer GUI”
menu from the main GUI under “Tools”

1 . M Picarro Analyzer Setup Tool (Flux)
FI g ure 46 ) Settings  Help
G U I PI‘OpeI’tIeS | Datalogger | PortManager | DataDelivery | GUIProperties | Command Interface | DataStrsaming | Electrical Interface |
Wi ndOW GUI Properties
Number of Graphs I
Enable Control of ¥alve Sequencer |vEs LI
Ta—
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Figure 47:
Command
Interface
Window

60

Specifying Digital Data Output for Command Interface

The Command Interface tab allows you to specify the data elements that
are sent via COM port/TCP (specified in the Port Manager tab). Two types
of data can be specified here: Datalog_User and DataLog_User_Sync.

After making the appropriate edits, click “Apply” to put changes into effect
and then “Exit” to close the window.

M Picarro Analyzer Setup Tool (Flux)

Settings  Help

| Datalogger | PortManager | DataDelivery  GUIProperties | Command Interface | DataStreaming | Electrical Interface |

Command Interface

Dutput Data Source

Output Data Columns cavity_pressure el
CavityTemp
WarmBoxTemp
EtalonTemp
DasTemp
Qutletvalve
salenoid_vakves
MPYPasition
species

CH4

CHa_dry

coz

CO2_dry

H20
AmbientPressure
CavityPressure
DataRate
Etalont

Etalonz
Fanstate
HatBoxHeater

EUEYCYCEY

HotBoxHeatsinkTemp
HatBoxTec
Inletyalve
Laser1Current
LaserlTec 2

| foply
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Specifying Digital Data Output for Data Streaming

The Data Streaming tab allows you to specify the data elements that you
want to send via COM port (specified in the Port Manager tab). Two types
of data can be specified here: Datalog_User and DataLog_User_Sync.

Data Streaming outputs data continuously, whereas the Command
Interface needs commands to prompt data output.

After making the appropriate edits, click “Apply” to put changes into effect
and then “Exit” to close the window.

H . M picarro Analyzer Setup Tool (Flux)
FI g u re 48 - Settings  Help
Data | Datalogger | PortMansger | DataDelivery | GUIProperties | CommandInterface | Data Streaming | Electrical Interface |
Streammg Data Streaming

Window

Data Stream Source

Data Stream Columns CavityPressure_sync
CavityTemp_sync
WarmBoxTemp_sync
EtalonTemp_sync
DasTemp_sync
Outletvalve_sync
MPVPasition_sync
CHa_dry_sync

CHé _sync
CoZ_dry_sync
COZ_sync

Hz0_sync
AMEMOMETER_C_sync
AMEMOMETER_UR_sync
AMEMOMETER_UY_sync
AMEMOMETER_UZ_sync
GPS_{EBS_LAT _sync
GPS_ABS_LONG_sync
GPS_FIT_sync
GPS_REL_LAT_sync
GPS_REL_LOMG_sync

CYESEYENES

GP5_TIME_sync
good
solenoid_valves_sync
syncstatus
timestamp

| foply

G5310 User Manual P/N 40-0012 Rev. E 61



PICARRO

Customizing Analog Output Channels

The Picarro analyzer may be optionally configured with an Electrical
Interface Card (EIC) that provides up to 8 analog signals available to the
user for monitoring various measurements results and analyzer
parameters.

Electrical Interface

The Electrical Interface tab allows you to customize each analog output
channel. This tab will be disabled if your analyzer was not configured to
work with an analog peripheral.

After making the appropriate edits, click “Apply” to put changes into effect
and then “Exit” to close the window.

Figure 49:
Electrical
Interface

Window

M Picarro Analyzer Setup Tool {Flux)

Settings  Help

| Dakalogger | PortManager | DataDelivery | GUIProperties | CommandInkerface | DataStreaming | Electrical Interface | |

Electrical Interface

62

Analog Output Channel Jo |
Data Source |Datalog_User_Sync |
Data Columns CavityPressure_sync ~|

CavvityTemp_sync
WarmBoxTemp_sync
EtalonTemp_sync
DasTemp_sync
Outletvalve_sync
MPWPosition_sync ]
CH4_dry_sync

CH4_sync

COZ_dry_sync

COZ_sync

H20_sync

ANEMOMETER_C_sync ~
Mode [Tracking =l
Slope Jo.oz
Offset B
Manual Voltage (0~10v) Jo
Min Voltage (D~10V) [0
Max Yoltage (0~10V) [0

Invalid Yalue Voltage (0~10V) |n

Electrical Interface Not Available

ey
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13. CALIBRATION

The two primary analytical measurements of the instrument are the concentration
of 12CHa4 and §13C-CHa. Periodic recalibration with standards of known
concentration maintains the accuracy of these quantities. Using the Data Recal
Software Utility (See instructions in Section 13.3: Calibration Software Utility Tools)
enables the calibration constants to be tracked over time, thus enabling the user to
follow system performance.

13.1

NOTE

13.2

Slope and Offset

Every Picarro analyzer ships with a default user calibration value of 1 for
slope and O for offset. While new user calibrations will likely result in
changes to both, we recommend that only offset changes are applied
during more frequent calibrations.

If a new slope calibration is to be applied, the user must be mindful of their
experimental uncertainty. For example, a change in the slope calibration
from 1 to 0.95 may not represent a change in the system’s linearity but
may simply reflect the experimental uncertainty. If during your slope
calibration, a new value of 0.9 or 0.85 is suggested by the Data Recal tool,
please repeat the measurements of your standards. In most cases, such
large changes in slope are a result of uncertainty and do not indicate a bad
nonlinearity of the analyzer. If your analyzer continues to suggest a large
change in slope, please consults with Picarro Support before applying a
new calibration.

If you are uncertain about the state of your current slope and offset
values, they can be reset back to their user default values of 1 and
0, respectively. In your Picarro GUI, navigate to “Tools -> User
Calibration -> (password: picarro) ->” Then change the slope and
offset values of your parameter of interest to 1 and 0, respectively.

Calibration Methodology

To perform a calibration or verification of calibration, the user simply
introduces the calibration standard into the analyzer for a period long
enough for the analyzer to yield a stable measurement of that sample.
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Calibration Setup
This section describes the connections from the analyzer to the gas tank.

e The pressure regulator at the outlet of the gas tank protects the
analyzer from over-pressurizing. The pressure should be set to
about 1 - 3 psi.

e The toggle valve allows rapid shutoff of the gas delivery.

e Tubing is connected to the male quick-disconnect connector
provided with the analyzer.

e The male connector is inserted into the inlet port of the analyzer.

To replace the gas tank:
6. Turn off the main valve on the gas tank.
7. Disconnect the pressure regulator assembly from the tank.

8. Connect the pressure regulator assembly to the next gas tank.

Measurement Time for Each Standard

The measurement period for a calibration standard is dependent upon the
recorded precision of the standard gas and performance characteristics of
the analyzer, using the Allan standard deviation plot.

Measuring Multiple Gas Standards

When measuring multiple gas standards, the order of the gas standard is
not important. However, make sure that you measure the gas standard
slightly longer than the time you determined in the previous section
because the usable/effective data set will be trimmed down.

Calibration Data Processing

1. Process the calibration results from the .dat file (see File
Management on page 53) and calculate the average recorded value
for each standard.

2. Plot these values versus the certified values from the gas supplier
and determine the linear relationship between the known calibration
values and the analyzer’s reported values. A linear best-fit equation
can be calculated from the data.
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NOTE

It is important to plot the analyzer’s reported concentration on the
horizontal axis and the gas standards’ stated concentrations on the
vertical axis.

Figure 50:
Linear
Calibration
Example

G5310 User

The slope and intercept of the best-fit line through these points are the two
values that are used to calibrate the analyzer. By determining the linear
relationship between the known calibration values and the analyzer’s
reported concentration values in this way, a calibration offset (slope and
intercept) can be calculated to add a correction term to the analyzer’s
factory or previous calibration.

Entering the Calibration Setting

Changing the analyzer’s calibration is intended to be done infrequently.
Instead of recalibrating frequently to increase the accuracy of the data,
users often just verify the calibration by measuring three or more gas
standards and use the same regression procedure described here to
calculate an offset by which to correct their data offline. Using the following
equation in the graph below, this calculation would be accomplished point-

by-point by calculating the corrected data “y” using the analyzer’s data “x”
so that:

Data corrected = 0.9866+Dataraw+5.268

Linear Calibration Example:
Calibration Stands vs Picarro Analyzer
700
<l y = 0.9866x + 5.2658
8 600 - /
=
S
® 500
&8
TS 400
S
£ W /
O (e}
E 200
S
o 100
O
0

] ] ] | ] ]
0 100 200 300 400 500 600 700
Concentration (as reported by analyzer)

Calibration values are input into the analyzer by selecting Tools > User
Calibration, and then entering the slope and intercept for each species.
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User Calibration is a password-protected form, and the default
password is “picarro”. This password can be reset in the
QuickGui.ini file as previously described.

The calibration will take effect immediately after clicking OK. To return to
the factory calibration, simply set the slope to 1 and the intercept to O for
each species.

Calibration Software Ultility tools

Data Recal

The Data Recal software utility is designed to enable users to perform a
routine concentrate calibration or calibration verification of Picarro’s gas
concentration Analyzer via a user-friendly interface.

Data Recal allows the input of ten calibration points. Some of these points
can be used for recalibration, while the remaining points can be used as
quality control calibrants. In an ideal situation, three concentration certified
standards should be analyzed on the system to generate CRDS-reported
values for concentration. The standards with isotopic values spanning and
encompassing the intended sample analysis should then be used to build a
standard calibration curve. Parameters of this curve will then be used to
correct the instrument readings so that they match standard values. The
other standards will be simultaneously used for quality control, to verify
other recalibrated delta values against their certified delta values.

Graphical User Interface (GUI)

The Picarro Data Recalibration (“Data Recal”) software can be found in the
“Picarro Utilities” folder on the desktop. The Data Recal software utility can
be launched by double-clicking on the Data Recal Icon in the folder. Shown
below is a screenshot of the window that will open.
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Figure 51: Recalibrstion®
Data Recal Fle Pict
Software Utility
GUI Delta Recalibration
Usind For Recal Cortified CROS Reported Foncalbrpted

= | -6 | “35.8 | 0.00000
¥ | 86 [ 76 | e.000m
= | 375 | 6.4 | o000
r | 13.6 | 13.2 | 0.00000
r [ o.00000 [ o000 [ o.00000
r [ ©.00000 [ 00000 | ©.00000
r | o.00000 | c.0000 | c.000m

The Delta Recal Software Utility comprises three sections:
1. A numerical input and selection section (shown below):

Certified and CRDS reported values are entered in the white
boxes. Standards that will be used for instrument recalibration are
then selected by checking the corresponding box in the first column,
labeled “Used for Recal.”
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Figure 52: i1
Recalibration File Plak
section of Data
Recal Software . .
Utility GUI Recalibration
IU=ed For Recal Certified CRDS Reported Recalibrated

v | -35.6 | -35.5 | 0,00000
v | 8.6 | 7.6 | 0.00000
v | 37.5 | 38.4 | 0.00000
r | 13.6 | 13.2 | 0.00000
r | 0.00000 | 0.00000 | 0.00000
r | 0.00000 | 0.00000 | 0,00000
I | 0.00000 | 0.00000 | 0.00000

2. Calibration output section (shown below):

In the “Calibration Options” drop-down menu, you can select either
an “offset” or an “offset + slope.” Once the new calibration
parameters are calculated, the Data GUI will display the new values
under the “New Calibration” column. The parameters that appear
here will depend on your initial selection. When the Offset + Slope
option is selected, the program also calculates a goodness-of-fit

correlation coefficient (RZ).

Figure 53:
Calibration
output section
of Data Recal
Software Utility
GUI

3. Action selection section (shown below):

In this section, the user can click on the compute button to calculate
the new calibration parameter(s). The compute button will be grayed

68 P/N 40-0012 Rev. E G5310 User Manual



PICARRO

out until values have been entered in the Certified and CRDS
reported columns, and at least one pair of Certified and CRDS
reported values selected for the calibration. Once these values are
entered or selected, the “Compute” button will be active. Click
“Compute” to calculate the new calibration parameters. These
parameters will appear in the Calibration output section of the GUI,
and an asterisk “*” will be displayed at the end of the window title
line, indicating the new change.

Figure 54:
Action selection
section of the
Data Recal
Software Utility
GUI

Apply New Ca

Figure 55:
Delta
Recalibration

G5310 User

Once the calibration parameters are calculated, you can elect to
graphically display the calibration and quality control (QC) standards in a
graph. To do this, click “Plot” in the upper left corner of the window, and
select “Plot Linear Fitting” from the drop-down menu, as shown below.

[ Recalibration® ;lglﬂ

File | Flat

Plok Linear Fitting i

Delta Recalibration

The plot that the utility will generate is shown below; this plot will display
two graphs. The top graph presents measurements for the recalibrated
standards (calibration and QC), as well as a line fit through those points.
The bottom graph shows the residuals, which shows how far each
measurement is from the best-fit line.
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Figure 56:
Slope of Delta
Recalibration

O S

&

If you decide to accept the new calibration values based on this plot, click
on the “Apply New Cal” button.

Figure 57:
Apply new
calibration slope
and intercept

Then you will be prompted to enter a Calibration Password. The default
Calibration Password is PICARRO.

Figure 58:
User
Authorization
Dialog box

70

Authorization required |
Please ensure you wank to change the calibration Fackors,
THIS ACTION CANMOT BE LMDCKNE.,
User Calibration Password:
sekkkkkbbk
O | Cancel |

Next, a “Recalibration Confirmation” pop-up window will appear, displaying
the new offset and slope (when applicable) values. This window will prompt
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you to confirm your choice to apply these values, to avoid any inadvertent
mistakes.

Figure 50: i
Calibration ow offest 1 7559
H H e arrse = 1.
Confirmation ! \  Mewslope = 055625
Dialog box
Are wou sure you wank to change?
Mo
Please note that when you press the “Yes” button, the newly accepted
calibration parameters will take effect immediately, without the need for the
instrument main GUI to be restarted.
Once you accept the new calibration parameters, the Data Recal Software
Utility automatically gives you the option to save the new recalibration file.
Saving these files enables you to track the instrument recalibration history.
Saved files can be reloaded by clicking “File” in the upper left corner of the
window and selecting “Load Recalibration File.”
H . [:”jm-obrahon Usech(al 00910 S_ 904.d [ .: o] x
Figure 60: (e s =l
Delta T
Recalibration , Delta Recalibration
Load File '
Next, select the file that you want to load.
FI g u re 61 Save Isol02 Delta Recalibration Configuration as... _ﬂﬁl
File Browser o EEEEEIYT d reoa
Delta Recal Eile & el
Optlon PN 12 seritecal_20050918_150528.cfg
ELECS il 13 usarmecal_20090921_102819.cfg
ﬂ; 13 Userfecal_20050921_135417.cfg
[ Userecal 200090930 _121910.¢fg
SR (3 Userecal_20090930_124536.cfg
[ UearRacsl_20090930_132921.cfg
‘ '3 UserRiecal_20091008_101509.cfg
My Documents
|'-Lr.
o)
My Compuies
-
r.n,.prﬁ..._{i:.. Flonme I EENORIETTE A [ ]
B ovoceive  [cighero | Cancel éll

G5310 User

The recalibration file for this example will contain the following information:
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Figure 62: Row Certified Measured Recalibrated
Delta Rec_al Number Values Values Values
Log File 1 -35.6 -35.8 -35.20437
2 8.6 7.6 7.64690
3 37.5 38.4 38.05748
4 cc 1.75599 0.55625
0.54922
1.8767
> ne 87678 0.99949
6 Option Offset + Slope

Rows 1 - 3: values from each standard selected for recalibration. The
first column in these rows lists the certified values, the second column lists
the measured values, and the third column lists the recalibrated values.
The number of rows will depend on the number of standards selected to be
used for recalibration.

Row 4: Current Calibration (cc) Row: read from left to right, list the
current offsetand current slope value.

Row 5: New Calibration (nc) Row: read from left to right, lists the new

offset and new slope values. The third value in this row is the R2 value,
which is only displayed if the calibration option is “offset + slope.”

Row 6: Options Row: The last row displays the calibration option
selected. If you choose to exit the Recal GUI before accepting the new
recalibration values, you will be prompted to confirm your choice through a
pop-up window. This window contains a warning that continuing to exit will
cause the new calibration data to be lost.

Figure 63:
Recalibration
Exit
Confirmation

72

Exit Confirmation |

Mew calibration not applied wet, Are wou sure you wank ko exik now?
' To apply the new calibration please click "apply Mew Cal* button before exiting,

Select "Yes" to exit without saving the new calibration,
Select "Ma" to cancel this action,

When you are finished with the calibration, you can exit the Delta Recal
software utility by clicking on the “Exit” button at the bottom part of the
Recal GUI.
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Figure 64:
Calibration
Exit Button

The Recal GUI displays an error saying the new slope value is not

acceptable when (1) at least two entries in the Certified or CRDS
@ reported columns contain zero-value numbers, or (2) these entries

are selected to be used for recalibration, or (3) the “offset + slope”
calibration option is selected. This error occurs because the
entered values will lead to an erroneous zero-slope value.

NOTE

Flg ure 65: Invalid new slope value 5'

Invalid New
Slope Entry e Mew slope value (=00 nok acceptable, Please change calibration setup and try again,
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14. STATUS LOG MESSAGES

14.1

Normal Startup Messages

Temperature Locked: WB

The system waits for the warm box (WB — the temperature-controlled
electronics and wavelength monitor chamber) to reach operating
temperature.

Temperature Locked: HB

The system waits for the hot box (HB — the temperature-controlled
chamber containing the analyzer’s optical cavity and gas handling system)
is stabilized.

This is typically the longest step in the startup sequence. The duration of
this step can range from 5 to 60 minutes, depending on the ambient
temperature and how much time has elapsed since the last startup.

Preparing to Measure

Spectral scanning has started. Concentration measurements will be
available in approximately 30 seconds. The analyzer continues to scan and
report concentration measurements until the analyzer is shutdown using
the procedure below.

Figure 67 shows an example of the status log messages for startup.

Figure 66:
Sample Status
Log Messages

for Startup

74

Pressure Stabilizing/Locked

The valve control system begins to allow flow through the analyzer and
stabilizes the pressure inside the cavity.

Measuring

This is the normal mode of operation after startup has completed.
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15. CONTROLLING EXTERNAL VALVES

This section explains how to control external valves using the built-in External
Valve Sequencer GUI.

If you are using the optional Picarro 16 Port Distribution Manifold with the analyzer,
see the 16 Port Distribution Manual User Guide for instructions on using the
External Valve Sequencer GUI.

15.1 Display the Show/Hide Valve Sequencer GUI
1. Start the analyzer by double-clicking the Start Analyzer shortcut on
the desktop.
2. Wait for the analyzer to begin measuring.

3. On the status bar menu of the analyzer Data Viewer screen, select
Show/Hide Valve Sequencer GUI dropdown (Figure 68).

The External Valve Sequencer GUI displays (Figure 69).

Figure 67: T
ShOW/HIde Settings  Wiew | Tools | Help
User Calibration
Valve P I ( Showe/Hide Yalve Sequencer GUL
Sequencer GUI

Figure 68:
External
Valve
Sequencer External Valve Sequencer
GUI ComentSiep & Rempereng Timg: [mn] Cument Valve Stae Curment vabve Code CumentRat wabe Code

[~ Weswsws| F Current Status Fields

S Buraten (el vabew Sa% wabm Code Bt wahon Sode
I 1 [ K] rrrerer |

I F] 1 (il ol el ol il il |

5 frrrrere] Step Definition Flelds
Use the valve state
I 1
A OECLoO] ! boxes to define the run

T @ frrrrer
s 5 prreerer]

I Used only with the
Used to set the I—— distribution manifold
valve sequence

al 2| 2| = = =

| Choose s step number ta run

Sat the total | A p— B e ’/‘
numslztro! —_ 1 Manually move to
aps

=) the next step

Set the start date Setﬂlum time ™ Click here to start the test at
forthe test the defined date and time

™~ Apply changes
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15.2 The External Valve Sequencer Window
This section describes the External Valve Sequencer window.
15.3 File Menu
Load a Valve Sequence File
Click here to load saved files. Sequence Files are in:
C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File
Save a Valve Sequence File
Click Action/Save Valve Sequence File to save a valve sequence file.
Figure 69: | File Menu
Valve Load a Valve Sequence File to Memory
Sequencer File S—— ‘ : —
|\/|enu M | xternal Valve Sequencer (C:\Picarro\G2000\nstrConfig\ValveSequencer\SSIM-samplebagPracticeload.s.... |._|
Load Valve Sequence File
Save Valve Sequence File
i External Valve Sequencer
Current Step = Remaining Time {min}) Current Valve State Current Yalve Code Current Rot, Valve Code
‘ ‘ . _ fesssss| | o
Save the current Valve Sequence File to Memory
15.4 Action Menu

76

See Figure 71 below.

Start Sequencer

Click here to start a sequence.

Go to First Step

Click here to run step one (automatically resets to 1 from whatever step is
currently being sampled).

Reset All Valves

Click here to change current valve states to All off.
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Hide Sequencer Interface

This toggle shows or hides the Sequencer Interface window. To reveal the
window click on the Show Sequencer Interface.

Figure 70:
Valve
Sequencer
Action
Menu

Action Menu

Bl External Valve Sequencer (C:\Picarro\G2000\InstrConfig\ValveSequencer\SSIM-samplebagPracticelLoad.s. .. |z|

Start Sequencer

Go To First Step

Reset Al Valves External Valve Sequencer

Hide Sequencer Interface

Current S-tEp = Remaining Time {min) Current Valve State Current Valve Code Current Rot. Valve Code

M SN VTV ] S— o

15.5

15.6

Current Status Fields

The top row on the menu (Figure 69) gives the current status of the current
step.

Current Step #

Gives the number of the current step as defined by the setup

Remaining Time (min)

Time remaining on the current step

Current Valve State

Check boxes indicate which valves are energized

Current Valve Code

Binary code representing which valves are energized

Current Rot. Valve Code

Used only with gas distribution manifold

Step Definition Fields

Use the step definition fields to define the test sequence.

Step #

Enter the step number.
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15.7

Duration (min)

Enter how long you want the step to last.

Rot. Valve Code

Used only with the gas distribution manifold

Bottom Panel

Use the bottom section of the window (Figure 69) to configure the sample.

Total Steps

Use this field to enter the total number of steps in the test. When the last
step is finished, the sequencer loops back to the first step.

Run Step #

Shows the number of step currently running. If a different step is desired,
enter that step number and click on Apply (Figure 43).

Apply
Click here to apply changes made using the External Valve Sequencer
window.

Run Next Step

Forces the next step in the sequence.

Start Date

Use this field to enter the date to start the test.

Start Time

Use this field to enter the time to start the test.

Schedule Sequence

Click this button to have the sequence start automatically at the date and
time specified in the Start Date and Start Time fields.
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15.8 Set Up a Test Sequence Using the Valve Sequencer
Window

A variety of sequences can be created and saved External Valve
Sequencer window. This section explains how to set up a test sequence
using the External Valve Sequencer window.

To set up a sampling sequence:

1. On the Picarro analyzer GUI, go to:
a. Tools
b. Show/hide valve sequencer

c. The External Valve Sequencer window displays. See Figure
69.

2. Use the Rot. Valve Code column to set the rotary selector valve
position.

3. Enter the number (1-16) that corresponds to the desired valve
position.

A value of 1 in the Rot Valve Code field corresponds to position 2 on
the valve. Only one rotary position can be selected per step.

4. Enter the Step duration in the Duration (min) field, where the
duration of the step is in minutes. If duration values are set to less
than 0.1 minutes they may not be carried out correctly.

5. Save the valve sequence as:

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the
Sequence File.

15.9 Load and Run a Saved Sequence

Load saved sequence files by clicking File/Load Valve Sequence. All the
Sequence Files are in
C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File.

1. Click Apply to run the sequence.

2. To skip the next step click Run Next Step (even while in middle of
running a step):

3. Click on the Action scroll-down menu.
4. Reset all Valves by changing all the Rot. Valve Code fields to Zero.

5. Click on Go to the First Step (Whatever the step the user is at, step
1 will be played).
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6. Click on Start/Stop Sequencer (while the sequence is running, it
will read Stop Sequencer).

7. Click on Hide Sequencer Interface (which will hide the External
Valve Sequencer window).

80 P/N 40-0012 Rev. E G5310 User Manual



PICARRO

APPENDIX A - REMOTE DATA ACCESS

A.1 Picarro Serial Communication

The analyzer supports an RS-232 physical command interface, which can
be used to control the instrument and to retrieve concentration data. Not all
features of the instrument are available on the serial interface. For details
on how to use the serial command interface, please see the Programming
Guide (included in pdf format on the installation CD). This command set
may also be used across a TCP/IP interface through an Ethernet
connection. Please contact Picarro for further details.

A.2 Remote Data Access

Using the RemoteAccess.ini file, the analyzer can be configured to
automatically:

e Send data from the instrument to a list of e-mail accounts.

¢ Measure the offset of the host computer system clock from a set of
Internet time servers and (optionally) to resynchronize the clock
based on this information.

The Internet connection need not be permanent and may be a dial-up
connection accessible via a user-supplied USB modem. The task of
sending data and/or synchronizing the clock on the analyzer is performed
using the C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This
program can be set up to run periodically using the Windows task
scheduler at a user-configurable frequency. If a dial-up connection to the
Internet is employed, it is used only on demand to minimize the connection
time.

Each time that the RemoteAccess.exe program runs, it appends
information to a log file, which keeps a record of the results of the time
synchronization and of the files sent by e-mail. The RemoteAccess.exe
program is configurable by means of an initialization file, which includes
information such as the login credentials for the dial-up connection, the e-
mail account and the list of time servers.

The initialization file is:

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess
Jani
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and it should be placed in the same directory as the executable
RemoteAccess.exe. The file has one required section named LOGGING
and three optional sections named NTP, DIALUP, and EMAIL. The logging
section has a single key Logfile whose value is the path to the log file.
Once this log file exceeds 64K bytes in length, it is backed up, appending a
numeric extension to the file name, and a new file is opened. A total of ten
backup log files are kept.

NTP

The NTP section controls querying the Internet time servers using the
SNTP protocol (RFC4330) and the resetting of the clock on the host
computer. If the section is not present, time synchronization is not carried
out. The keys Serverl, Server2, etc., are used to specify the URLs of the
time servers. If the UpdateClock key is set to “true,” the offset is applied to
the host clock. Otherwise, the offset is recorded, but the host clock is not
changed.

Email

The EMAIL section controls the sending of the data files as e-mail
attachments. If the section is not present, e-mail messages are not sent.
The key Directory specifies the directory that contains the data files. When
the program is run, files in this directory are sent to the specified recipients
and the files are deleted. To avoid problems with incomplete files,
programs that place files into this directory should do so using an atomic
operation, such as a rename. The Server key is set to the name of an
RFC2821- compliant SMTP server that sends the e-mail messages.

The FROM key is the e-mail address from which the messages are sent.
Note that some SMTP servers check that the source is permitted to send
email while others allow any name in this field. The collection of e-mail
addresses to which copies of the e-mail is sent is specified by the keys
Tol, To2, etc. The Subject key is used to fill the subject field in the email
header and may be set to any string. Depending on the SMTP server, it
may be necessary to use authentication before e-mails can be sent, as
described in RFC2554. If such authentication is not needed, the key
UseAuthentication is set to false. If this key is set to true, two additional
keys Username and Password must also be specified for the e-mail
account.
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Dial-up

The DIALUP section is used if a dial-up connection to the Internet needs to
be established when the program runs. If the section does not exist, a
permanent connection is assumed to be available for carrying out the other
tasks specified in the initialization file. The connection name key specifies
the name of the dial-up connection to use, as listed under Network
Connections in the Control Panel. The values of the keys Username,
Password and Number are used to make the connection.

Examples of “RemoteAccess.ini” File

[LOGGING] Logfile=c:/temp/RemoteAccessLog

Serverl=time-a.nist.gov
Server2=time-b.nist.gov
Server3=time-a.timefreqg.bldrdoc.gov
Server4=time-b.timefreq.bldrdoc.gov
[NTP] Server5=time-c.timefreq.bldrdoc.gov
Server6=time.nist.gov
Server7=time-nw.nist.gov
UpdateClock=1

ConnectionName=Picarro Dialup
Access Username=user
[DIALUP] Password=password
Number=14085551212

Server=smtp.servername.org
Directory=c:/picarro/mailbox
From=instrument@picarro.com

[EM Al |_] Tol=recipientl@sitel.com
To2=recipient2@site2.com

Subject=CRDS data from Silverstone instrument
UseAuthentication=0

G5310 User Manual P/N 40-0012 Rev. E 83



PICARRO

APPENDIX B - THE DATA FILE VIEWER

B.1 Introduction
The Picarro Data File Viewer software is located in the Picarro Utilities
folder on the desktop. The software allows the user to graph and to
conduct statistical analysis of the raw data. Additional functions include
Allan Variance plot and quadratic or polynomial fittings.
The Picarro Data File Viewer includes two main menus: File and New.
Figure 71: & picarro Data File Viewer 3.0.0 | ] ]
File Menu File| New Help
Open H5 File... Ctri+0
Load Config...
Unpack Zip File... Z
Concatenate H5 Files... F
Convert DAT to H5... Alt+Shift+C
Convert H5 to DAT... Alt+C
Batch Convert DAT to H5... B
Batch Convert H5 to DAT... C
Interpolation...
Block Average..
Exit
Figure 72 & Picarro Data File Viewer 3.0.9 ™
New Menu
File |New | Help
Data Time Series Plot (1 Frame)...
Time Series Plot (2 Frames)... 2
Time Series Plot (3 Frames)...

B.2 The File Menu

84

This section describes the functions available from the Data File Viewer File
menu.

Open H5

File > Open H5 opens a Picarro data file (HDF5 format) for data analysis and
visualization. After opening the data file, you can create a new time series
plot. Refer to New Time Series Plot for more information.
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Load Config

File > Load Config loads a configuration file (ini format) to restore
parameters of a workplace. Refer to Save Configuration for more information.

Unpack Zip File

Use File > Unpack Zip File to concatenate all H5 files inside the zip file into
a single H5 file. Refer to Concatenate H5 Files for details.

Concatenate H5 Files

Use File > Concatenate H5 files to concatenate multiple files and zip
archives of H5 files into a single H5 file. Navigate to the desired folder or use
the Define date range button to specify a date range of files to concatenate.
(See next section.)

After selecting the path of the data files, Data File Viewer will automatically
search an H5 file in the specified zip/folder and look for all available
variables in the H5 file. The variables are then listed in the left panel, and
users can use “>>” putton to move variables to the right panel for
concatenation.

Figu re 73: & Select Variables =B X |
Select Variables Left panel lists avariable variables in the selected HDFS files.

Form Please select variables to be concatenated in the new file. Define date range
Click button on the right to only concatenate files with specific date range.

" | Large dataset. Click 'Help' to see details about this option.
57 c:\users\yren\appdata\local\tem 5> ) New File

55 Jresults =

[5 12CH4_high_range =
8

- [5] ALARM_STATUS

~[5 AnalyzerStatus

--[3) CFADS_base

i[5 CFADS_base_avg
CFADS_ch4_amp
CFADS_ch4_y

: CFADS_h20_conc

[ cHe

- [3 cHem_DETECT x

<« (o] )

DD

| ok || cancel |[ help |
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Define Date Range

Data File Viewer can search data files within the desired date range and
then concatenate such files into an H5 file.

By default, TimeZone is set to your local time zone. However, if data were
taken elsewhere, select the time zone where data were taken.

Select File > Concatenate H5 files, then click Define date range to specify
the desired date range.

Figure 74:
Defining Date
Range

r | = 1
Select Date Range e |12 PX4 ‘
Select Starting Point Select Ending Point
Start Date  11/16/2015 %] End Date 11/16/2015
Start Time  12:00:00 ax %] End Time  12:00:00 a4 =
| TimeZone  [America/Los_Angeles v
Data files are saved in directory trees named by date and time.
(‘*—’: — — ——— ~ T ——— 4

Data files are saved in directory trees named by date and time option.

Picarro software saves data in a directory tree that is named by the
creation year, month, and day. (See example directory tree in the following
image.) Select this option if the target folder has this file structure. This
way, Data File Viewer will only search folders within the desired date
range, which can substantially reduce processing time.

_ Figure 75: 4 | Datalog_Private
File Structure of
Data File 4 | 2015
Viewer > b 08
4 | 09
4| 14

86

» 1 Datalog_Private_20150914_210942.zip
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%

NOTE

CAUTION

B

NOTE

To save processing time, Data File Viewer does not open data files,
but only determines data acquisition time based on the file name.

Do not define atime range for data files whose names have been
changed.

Data File Viewer does not concatenate data files exactly within the
defined time range. This is because the time extracted from file
name is different from the data acquisition time. To not miss data
points, Data File Viewer expands the specified time range, so the
resulting dataset normally has a wider time range than the user
specification.

Convert DAT to H5

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5
format. These formats are described below:

o DAT format: DAT files accepted by DatViewer store tabular data
(numbers and text) in plain text.

e Each line of the file is a data record. Each record consists of one or
more fields separated by whitespaces.

e The first line of data file indicates column names.

e There must be a field “EPOCH_TIME” to store the acquisition epoch
time (expressed as seconds since Jan 1, 1970) of the data.
Otherwise, the first and second fields must be “DATE” and “TIME”.
The “DATE?” field must have the format “mm/dd/yyyy” or “yyyy-mm-
dd”, and the “TIME” field must have the format “HH:MM: SS(.sss)’
where (.sss) is an optional fraction of seconds.

e HDF5 format: HDF5 is a data model, library, and file format for
storing and managing data. (See the HDF5 Home Page on the HDF
Group Web site for more information.) When converting DAT to
HDF5 format, Data File Viewer creates a table named “results” to
the contained data.

Convert H5 to DAT

Select File > Convert H5 to DAT to convert a file in a HDF5 format to
DAT. These formats are described in Convert DAT to H5.
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%

NOTE

NOTE
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Data File Viewer does not concatenate data files exactly within the
defined time range. This is because the time extracted from file
name is different from the data acquisition time. To not miss data
points, Data File Viewer expands the specified time, column name
“fineLaser-Current_1_controlOn” will be replaced with
“fineLaserCurr_1_ctrilOn”.

Interpolation

Interpolation describes the method for constructing data points with a
range of a discrete set of known data points. Select File > Interpolation to
perform interpolation on a time grid with a constant interval.

Block Average

Select File > Block Average to divide a dataset into small blocks based on
a user-defined block size. The average is calculated for data in each block,
and the results are saved in a new H5 file.

The specified block size must be greater than the average data
interval.

Because the data interval is normally not a constant (unless interpolation is
performed), fluctuations in the data interval will affect block averaging if the
block size is comparable to the average data interval.
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B.3 New — Time Series Plot

You can specify to include create time-series plots with one, two, or three
frames. New plots display in the Time Series Viewer.

FI g u re 76 . % Time Series Viewer: C:\Picarro\G2000\Log\test\HKDS2036-20150521-083330Z-DataLog_Private.h5 =B X
. . i File  Analysis’ View Help
Time Series eto et nme e -]
VleWer 3| VarMnjAVe:Vth -
: o1
1 Average
£ R Ty

7 Mean: -0.110728248954
& e 063412806858
-3

Peak to peak: 7.9596862793

012045 013824 014702 015040 020419 (27207 (22135 (@301 (23852
20150521 20150621 20150521 20150521 20150521 20150521 20150521 20150521 20150521

Data set name: |fresults ~]
20000 Var name: [H20 -]
tpaonly (i)
15000 Average
ey ™ .7 -
8 i PN )

Mean: 9623.31347656
00 § o St dev: 9773.39257812
Peak to pesk: 22314.5917969

01:2945 013824 0147:02 015540 (20419 (R1257 22136 ®@3I014 (R3IES2
20150621 20150621 20150521 20150521 201N0621 20150521 20150621 201505721 20130621

Filter: (CH4<S) & (CH4>-5)

The next section describes the options available on the Time Series Viewer
menu bar. Refer to Time Series Viewer Canvas on page 93 for information
the Time Series Viewer Ul features and options.

B.4 Time Series Viewer Menus

The Time Series Viewer form includes the following menus:

Figure 77: File [Analysis| [View]
Time Series Save Configuration... Statistics ©  x-Axis in Datetime
Viewer Menus Take ScreenShot... Histogram x-Axis in Minute
Correlation Plot x-Axis in Hour

Allan Standard Deviation Plot

Time Series Viewer File Menu

Use the File menu to save a configuration or take a screenshot.

Figure 78: A Fﬂe.l
Time Series N
Viewer — File Save Configuration...
Menu Take ScreenShot...
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Save Configuration

Click File > Save Configuration to open the Feature Capture form. With
this form, you can save figure properties, expressions, filters, and other
settings to a configuration file so that it can be easily loaded in the future.

Figure 79:
Time Series
Viewer —
Feature Capture

CAUTION

90

% Feature Capture E

Select features that will be captured in the configuration file.

Data file:[v| Filter:[v| Expression:[V]
Figure Property
X range:[¥| Y range:[V]

OK

If a feature is not captured, it will be omitted when the configuration
file is loaded.

Depending on the features captured, loading a configuration file can have
different effects. For example:

o |If all features are captured, a saved workplace is reproduced.

o |f Data file is not captured, saved parameters will be applied to the
data file in memory.

e |f Expression is not captured, plots will not be transformed.

e If X (Y) range is not captured, figures will be auto-scaled on the x (y)
axis.

Take ScreenShot

Use File > Take ScreenShot to take a screenshot of the Time Series
Viewer and save it as a .png to a specified file.

Time Series Viewer Analysis Menu

Use the Analysis menu to calculate statistics, generate a histogram, and to
plot correlations and Allan Standard deviations.
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Figure 80:
Time Series
Viewer —
Analysis Menu

| Analysis |
Statistics
Histogram

Correlation Plot
Allan Standard Deviation Plot

Statistics

Use Analysis > Statistics to calculate mean, standard deviation and peak
to peak for all plots in the current window.

Histogram

Use Analysis > Histogram to generate a histogram of data as shown
below.

Figure 81:
Histogram
Window

G5310 User

~

% Histogram: CH4 =8| X

120

[[=-0.0581665452995|
0 = 0.300847068916

Bin: 100 Normalized: | | [ Save data ] [Save image

-

¢ Red Line: A Gaussian function fitted to the histogram. Fitting results
of y and o are shown in the top-left corner of the plot.

¢ Bin: Specifies the number of intervals that the range of values is
divided into.

Manual P/N 40-0012 Rev. E 91



PICARRO

¢ Normalized: When selected, the sum of the histograms is
normalized to 1.

e Save data: Saves histogram data to a CSV file.
e Save image: Saves the histogram image as a JPEG/PNG/PDF file.

Correlation Plot

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus
that in the other. This can be used when two or more frames exist in the
current Time Series Plot window. See Correlation/XY Plot on Page 95 for
details.

Allan Standard Deviation Plot

Use Analysis > Allan Standard Deviation Plot to create an Allan
Standard Deviation plot (versus a standard deviation plot) for data in the
current window. See Allan Variance for more information.

Time Series Viewer View Menu

Use the View menu to view X-axis information in date-time, minute, or hour
format.

Figure 82:
Time Series

Viewer —
View Menu

|Viéw|
© x-Axis in Datetime
x-Axis in Minute

B

NOTE

92

x-Axis in Hour

When switching from DateTime to Minute or Hour, the X-axis data
is subtracted from the earliest point shown in the panel and then
converted to the desired unit.
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The Time Series Viewer Canvas

The Time Series Viewer canvas is comprised of interactive graphs and a
variety of configuration options.

FI g u r e 83 . & Time Series Viewer: C:\Picarro\G2000\Log\test\HKDS2036-20150521-0833302-DataL.og_Private.hS =@ X

. . File Analysis View Hel
Time Series . :
Viewer Canvas

Data set narme: [/results v
Ver name: [CH4 |

Expression: ¥ Load script
(LLond scrpt |

Average
Autoscale ViVl gae:1 plocki ][ Do average

Mean: -0.110728248954
Std dev: 0.63412886858
Peak to peak: 7.9596862793

&

3
2
1
()
-
-2
-3
-4

12945 014702 015540 020419 (21257 (22136 @30

o 013624 3852
20150521 20150621 0150521 20150521 20150521 20150521 20150521 20150521 20150621

Data set name: |fresults -

ity Var name: [H20 B

Expression: Load scrpt
{15000 Average
§ 10000 Auozale Y] gae:1 ookl ([0 overage |

Mean: 9623.31347656
H H Std dev: 9773.39257812
Peak to pesk: 22314.5917969

01:2545  01:3824 014702 015540 (20419 (21257  (221:06 (3014 0038
20150621 20150621 20150321 20150521 201N0621 201505721 20150621 201505721 201N0621

Filter: (CH4<S) & (CH4>-5)

Mouse Options and Graph Transform
The following mouse actions can be used in the canvas graphs:
e Left click and drag: Zooms into the selected area of the plot.
e Left click and drag with the SHIFT key down: Pans the plot.
e Left click and drag with CTRL key down: Zooms out from the plot.
e Left click and drag with ALT key down: Stretches the plot.

¢ Right-click: Opens an additional menu. Refer to the next section.

Right-click Menu

Right-clicking on the canvas provides opens a pop-up menu.

Figure 84: Export Image
Can\??i Rlvllg ht- Export Data in Current View
click vienu Export All Data in Current Time Range
Edit Plot properties
Statistics

Export Image: Exports the current plot as a jpeg, png, or pdf file.
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Export Data in Current View: Exports only date/time and the selected
variable in the current view to an HDF5 or CSV file.

Export All Data in Current Time Range: Exports all variable columns of
the selected dataset in the current time range to an HDF5 file. Refer to
Concatenate H5 Files on page 85 for more information.

Edit Plot properties: Opens the Image Editor form, where the following
options can be specified:

o Title: Edits the title of the plot.

e Line: Specifies the line pattern of the plot. If None is selected, the
data points will be plotted without connecting lines.

o Marker: Specifies the marker type to indicate data points. If None is
selected, data points will not be shown.

¢ Min and Max: Specifies the minimum and maximum of data range
for the X-axis and the Y-axis.

o X[0]: Sets the earliest time of the dataset as the minimum of the X-
axis.

e Time zone: Sets the time zone for date/time variables. This defaults
to the local time zone.

e Label: Specify a label for the X-axis and the Y-axis.

Figure 85: & image Editor e
Image Editor
Form Title: CH4| Une:‘SoIld v Marker:
X-Axis
Min: 2015-05-21 08:49:27 .m Max: 2015-05-21 09:13:24
Time zone: UTC N
Label:
y-Axis
Min: -23.8257882053 Max: 17.1888838139  Label: CH4
[ Apply 1[ Cancel ]

e Statistics: Calculates the mean, standard deviation, and peak to
peak for data in the current view.
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9,

REMINDER

9,

REMINDER

Dataset Name and Var Name

An HDF5 file can store one or more tables. Each of these tables is called a
Dataset. A table can contain one or more columns. Each column is called a
variable (Var).

Use the Dataset name drop down to select the dataset that will be used for
this time series graph. Use the Var name drop down to select the column
in the dataset to use in the graph.

Autoscale Y

When the Autoscale Y option is selected, the Time Series Viewer will
autoscale on the Y-axis to make sure that all data within the range of the X-
axis is displayed.

Average

If Block is selected, a block average is calculated when you click the Do
average button is clicked. Otherwise, a moving average is calculated.

For a block average, Size specifies block size in unit of a minute. For a
moving average, Size specifies subset size in unit of data points.

Averaging is performed after the Filter and Expression are
performed.

Mean, Std Dev, and Peak to Peak

The Mean, Std dev (Standard deviation) and Peak to peak fields provide
all the statistical information of data in the current view.
Correlation/XY Plot

The Correlation/XY Plot window includes two menu items: File and
Analysis. For details about the File menu, see Save Configuration on
page 90.

The canvas in this plot is interactive. For details about the plot
canvas, see The Time Series Viewer Canvas on Page 93.
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Figure 86: & C:\Picarmo\G2000\Log\PressureCal\RD_1427515203399.h5
Correlation/XY
Plot

File Analysis

32000 ¢

Foamr
—

31500

fineLaserCurrent

31000

30500

y =pl *sin(p2 * x + p3) + p4 -
pl = 818.710060933 £6.12592183345

p2 = 0.850525910612 £0.00133083595288

p3 = 8.69295128676 £0.0611152701352

p4 = 31312.8160731 =4.30784473633

Analysis Menu

The Analysis Menu includes three options: Fitting, Integration, and
Statistics.

e Fitting allows you to specify one of four fitting methods to include in
the Correlation/XY plot:

I.  Linear fit: Specifies to fit to linear function y = cax + co

ii. Quadratic fit: Specifies to fit to quadratic function y = c2x? +
CiX + Co

iii.  Polynomial fit: Specifies to fit polynomial function of degree
n:y = Zcnx"

iv.  Curve fit: Specifies to use non-linear least squares to fit an
arbitrary function to data.

Figure 87: Analysis
Analysis
. Fitting »|  Linearfit
Integration Quadratic fit
Statistics Polynomial fit
Curve fit

96 P/N 40-0012 Rev. E G5310 User Manual



PICARRO

e Integration calculates area under the curve using the composite
trapezoidal rule.

e Statistics calculates mean, standard deviation, and peak to peak
for data in the current view.

After applying any of the above Analysis options, the results, statistics, or
fitting function with coefficients are displayed in the lower portion of the
Correlation Plot window.

Figure 88: ;
Results of . i
Quadratic 1138

Fitting

w = sumic[n] * xn)

c[2] = -4996 48642435 £445. 328371775
c[1] = 11164339185 102351625669
c[0] = -5753. 37675095 £534, 159615694
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APPENDIX C - LIST OF PARAMETERS

These parameters can be toggled on the GUI. See the section Setup Tool for how
to access this stored information.

Be aware that the parameters are alphabetized by parameters starting with capital

letters first before parameters starting with lowercase letters.

List of Parameters

Unit

Explanation

Co

ppb

Wet CO concentration reading with corrections

CO_dry

ppb

Dry CO concentration reading, water corrected

CavityPressure

Torr

Reading of cavity pressure. Operating pressure is
100 Torr

CavityTemp

Celsius

Average temperature reading of 4 thermistors
along the cavity. Operating cavity temperature is
very close to 40 Celsius

ChillerTemp

Celsius

Temperature reading of liquid in the chiller. The
chiller is used to remove heat from laser and keep
laser baseplate temperature constant

CoolBoxHeatsink1Temp

Celsius

Temperature reading of one TEC used to keep
CoolBox temperature constant. Operating
temperature is about 42 Celsius

CoolBoxHeatsink2Temp

Celsius

Temperature reading of the other TEC used to
keep CoolBox temperature constant. Operating
temperature is about 42 Celsius

CoolBoxTec

digital reading of CoolBox TEC current. Above
32000 means that TEC is heating; below 32000
means that TEC is cooling

DasTemp

Celsius

Temperature reading of Electronics boards. The
reading is usually about 10 Celsius higher than
ambient temperature

EtalonTemp

Celsius

Temperature reading of Etalon in Wavelength
Monitor. Etalon temperature is set at 40.000
Celsius.

CoolBoxHeater

Digital reading of heater current. The heater is
underneath the CoolBox. It is used to heat the
CoolBox. For this unit, the heater is not used

H20

PPM

H20 concentration reading

InletValve

Digital reading of Inlet Valve current. Default
setting is 50000

Laser1Current

mA

Laser current reading. There is one laser in the unit

LaserlTec

Digital reading of laser TEC current. Above 32000
means that TEC is cooling; below 32000 means
that TEC is heating

LaserlTemp

Celsius

Mean laser chip temperature reading. For each
spectral scan, the laser chip temperature changes
about 1 Celsius
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List of Parameters Unit Explanation
Digital reading of Laser chiller TEC current. The
LaserBasePlateTec laser chiller TEC is used to remove heat from
chiller liquid
Temperature reading of Laser Baseplate. The laser
LaserBasePlateTemp Celsius is mounted on the baseplate. The baseplate
temperature is set at 25-30 Celsius
MPVPosition Rotary valve position (from 1 to 16)
N20 ppb N20 concentration reading with corrections
N20_dry ppb Dry N20 concentration reading, water corrected
OutletValve Digital reading of outlet valve current
Temperature reading of one thermistor along the
P2Temp Celsius cavity. This thermistor is located close to front
mirrors
Temperature reading of second thermistor along
P3Temp Celsius the cavity. This thermistor is located close to
Wavelength Monitor.
Temperature reading of third thermistor along the
PATemp Celsius cavity. This thermistor is located close to Ringdown
Detector
Temperature reading of fourth thermistor along the
P9Temp Celsius cavity. This thermistor is located close to rear
mirror
Temperature reading of Wavelength Monitor. The
WIimTemp Celsius thermistor is mounted on the invar plate inside the
Wavelength Monitor
basel ppb/cm average baseline value for peakl
base31 ppb/cm average baseline value for peak31
base40 ppb/cm average baseline value for peak40
base50 ppb/cm average baseline value for peak50
13CO2 concentration reading based on peak40
c1302 ppm (*3C02). This is only used for a reference, not for
accurate CO2 measurement.
interval seconds time period of each spectral scan
ngroups Number of wavelength points per spectral scan
numpoints Number of total RingDowns per spectral scan
Strength corresponding to N20 concentration
strl - o
derived from fitting
strl_spec strl with cross-talking and thermal corrections
stri_dry TC strl Wlt'h cross-talking, thermal and wet-dry
corrections
stral Strength corresponding to H20 concentration
derived from fitting
str40 Strength corresponding to 13CO2 concentration
derived from fitting
Str50 Strength corresponding to CO concentration

derived from fitting
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List of Parameters

Unit

Explanation

str50_spec Str50 with cross-talking and thermal corrections
Str50 with cross-talking, thermal and wet-dry

str50_dry_TC corrections

pzt_adjust PZT adjustment

pzt_offset PZT offset
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APPENDIX D - ANALOG SIGNAL OUTPUT

D.1 Overview

The G5310 is configured with an optional Electrical Interface Card (EIC)
that provides 4 analog signals for monitoring various measurement results
and analyzer parameters.

Two circular connectors, on the back panel of the analyzer are available for
analog output. The pinout for each connector is listed in the table below.

Figure 90 shows the analog channel connectors on the back of the

analyzer.
Flgu';ﬁa?(?é Analog Channels 4-7
Channel Analog Channels 0-3
Connectors

Two external cables (for the analog channel connectors) are provided with
the analyzer. The mating connector is part number HR25-7TP-8P(72)

D.2 Analog Signal Pin Mapping

The table below lists the analog pinouts and Figure 91 shows the analog

G5310 User Manual

pinout map.

Pin Function Pin Function
1 GND O 1 GND 4

2 Channel 0 2 Channel 4
3 GND 1 3 GND 5

4 Channel 1 4 Channel 5
5 GND 2 5 GND 6

6 Channel 2 6 Channel 6
7 GND 3 7 GND 7

8 Channel 3 8 Channel 7
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Figure 90:
Analog Pin
Map

D.3 Configuration

The default configuration is set at the factory and is listed in the table
below. It can be modified by editing the electricallnterface.ini file located in
the C:\Picarro\G2000\AppConfig\Electricallnterface directory.

D.4 Analog Output Configuration

+1 volt indicates 0 in all cases: Each channel has a +1 volt offset. Treat
<=0 volts as an error. This helps prevent reading the wrong values
because of improper wiring (ground loops).

Example for Channel 0: 1V = 20ppb with a 1V offset. 9v x 200 ppb/V = 180

ppb = 1.8 ppm.
Analog Configuration Master Table
Channel Parameter Output Scale Conversion Indicating
(<1V indicates | All channels Range
error) have a +1V 1Vto 10V or 0
offset to 90 ppb
(+1Vv=0)
0 0-10vV 10 ppb/V 0to 90 ppb
1 0-10vV 100 ppb/V 0t0 0.9 ppm
2 0-10V 2%IV 0to 18%
3 DAS temp 0-10V 10° C/V 0to90°C
4 None NA NA NA
5 None NA NA NA
6 None NA NA NA
7 None NA NA NA
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